Welcome to NX 10

December 2014

Dear Customer:

We are proud to introduce the latest release of NX. Siemens PLM Software has a clear and consistent strategy: to provide Digital Product Development and Manufacturing solutions that help you transform your product development process.

NX 10 is a major release with significant new functionality in all areas of the product, and we believe that the new and enhanced functions will help you become more productive.

Design

In the design environment, we have invested in all aspects of modeling including significant enhancements to feature modeling, freeform modeling, and synchronous technology, in a new layout environment for 2D conceptual design, as well as in core functionality such as visualization and user interaction.

We have continued to invest in your core workflows. With NX 9, we introduced the concept of Synchronous Technology in 2D sketching, which removed the need to pre-create constraints to get logical changes, automatically recognized relationships such as tangency, and used similar approaches to 3D conditions such as symmetry and parallelism.

We have further invested in this technology with a number of enhancements that expand the flexibility which Synchronous Technology in 2D delivers. This technology can make editing 2D drawings and imported profiles such as DXF quick and easy, saving you time and money and increasing your ability to reuse legacy data. To ensure good quality data, we have introduced a 2D geometry optimization tool that allows you to clean imported 2D data removing overlapping objects, fixing small gaps in profiles, etc.

With NX 10 we have included a number of key projects that enhance performance, making use of your computer hardware to multi-thread display regeneration after an update, and giving you tools to modularize your design for faster update. For users with large feature trees that contain many operations, Part Modules has been enhanced to allow you to easily structure your feature tree into manageable portions, allowing you to be in control of exactly what is updated and when.

Other enhancements to feature modeling include:

• A new set of aerospace design features for the creation of airframe structures.

• Improved pattern tools.

• Increased capability to identify missing faces when modifying parametric models.
For those of you who develop complex freeform geometry, NX 9.0.1 introduced NX Realize Shape, a new approach to creating highly stylized models. We have continued to invest in this technology adding new construction tools to allow increased flexibility when creating organic shapes.

NX 10 introduces NX Layout, an easy to use 2D conceptual design environment which is fully integrated into the NX Drafting application. NX Layout provides a number of dedicated tools to support 2D design and layout. You can explore concepts in 2D and then use that data to generate 3D models and assemblies.

With NX 9 we introduced the Microsoft Ribbon approach for user interaction. With NX 10 we have implemented a number of enhancements following your feedback to make the user interaction model more efficient. In addition to these changes we have introduced support for dual monitors. If you work on two monitors, you can now position the navigators on the second monitor, and use your primary monitor purely for graphics.

NX 10 also introduces support for touch devices; with the new roles and the multi-gesture support for using NX on a touch panel or touch enabled PC, you can be more productive than ever.

CAE

Highlights of the NX CAE 10 release include:

- A new multiphysics environment to connect two or more solvers to streamline the process of performing complex, multiphysics simulations.

- The ability to solve thermo-mechanical problems in loosely-coupled or tightly-coupled modes.

Simulation modeling and results visualization enhancements include:

- Adaptive meshing capability for better convergences and accuracy of structural, thermal, and multiphysics solutions.

- New expression functions, quantities, and an evaluation system that simplify the task of defining interdependent loads and boundary conditions.

- The ability to extract relationships in results data during postprocessing to develop a greater understanding of the model’s physical behavior.

Structural analysis enhancements include:

- The ability to simulate complex phenomena in composites like delamination and progressive failure.

- Integrated, end-to-end vibro-acoustics workflow to increase productivity for automotive NVH analysis.

- A new environment for the LMS Samcef Solver Suite, which offers a nonlinear finite element solver for structural analysis covering a wide range of applications in the aerospace, defense, and automotive industries.

Thermal analysis enhancements include:

- The ability to define thermal boundary conditions with symbolic expressions containing quantities that can be evaluated only at solve time and updated as needed during the solution sequence.
• An adaptive time stepping scheme to handle sharp changes in temperature at boundary conditions.

Flow analysis enhancements include:
• The ability to create a boundary layer mesh in the finite element model file with the NX Advanced Fluid Modeling module. This allows greater control over a boundary layer mesh, because you can visualize it and use all the mesh controls and quality checks you normally would with any FE mesh.
• The ability to export the boundary layer mesh to a CFD general notation system (CGNS) file for use with other CFD solvers.
• Mesh wrapping capability to generate fluid bodies from models for which you have mesh data but no geometry.
• Extensions to the parallel flow solver for homogeneous gas mixture and tracer fluids, high-speed flows, shear stress transport (SST) and K-omega turbulence models, and non-Newtonian fluids.
• Two-phase, immiscible fluid simulation enhancements that include the ability to simulate two liquids or gases and simulate open volume enclosures, such as the filling or emptying of a tank.

Simulation process automation enhancements include NX Open support for the Python scripting language to automate simulation workflows.

CAM

NX Manufacturing has also been enhanced to improve productivity when generating manufacturing data.

NX CAM 10 introduces new industry-specific capabilities for part manufacturing that enable faster programming and better quality machining of parts.

Mold and die machining

Optimized roughing: The new roughing strategy in NX is especially useful for more complex parts that require different cutting strategies for different regions. NX automatically adjusts the cutting method region-by-region and level-by-level, ensuring improved cutting conditions in each machined area.

Cut region control for rest milling: The interactive cut region control functions have been extended to cover Flowcut, so you can specify a range of cut patterns for steep, shallow and flat areas. To ensure that the best cutting method is used for each corner or valley, you can preview, change, and reorder the regions before generating tool paths.

Prismatic part machining

Group features: Using feature-based machining, holes are identified, filtered and grouped automatically. Holes sharing similar attributes are programmed together so that they share tools. On the shop floor, the optimized machining process can reduce machining time and increase accuracy.

Chamfer milling of holes: You can now apply the powerful hole-milling approach to a common feature with a minimum of programming input. NX 10 enables you to automatically calculate the correct tool offset for chamfering multiple holes and generating a circular milling tool path.

Efficient drilling paths: The new optimized sequencing in NX enables you to improve drilling operations by specifying the desired drilling pattern and selecting the best start position. The
subsequent operation can start where the previous one ended, reversing the cutting direction, and thus further maximizing performance of the machine tool.

**Complex part machining**

Swarf cutting of blades: We have enhanced swarfing in the NX Turbomachinery Milling module so that you can now achieve exact alignment of the tool with the blade geometry. You can finish complex blades with a single pass using the entire length of the tool, which can produce a high-quality surface finish.

5-axis machining of rotary parts: The enhanced strategies in NX 10 make it simple to create efficient 5-axis machining operations for large rotary parts, such as aircraft engine casings. Select a single edge and NX will generate all the necessary operations to machine cylindrical faces or chamfer an edge.

**CMM Inspection**

NX CMM 10 features powerful programming capabilities that let you create accurate and safe inspection paths automatically. The results analysis module enables you to import and compare multiple results sets to improve the quality control process.

Automatic collision avoidance enhancement: The expanded automated collision avoidance methods include adjustment of the inspection pattern. For example, a touch point positioned too close to another surface will be automatically moved far enough to avoid any interference.

Scanning paths automated: New automated inspection programming capabilities in NX CMM enable the use of PMI to create inspection scanning paths. This helps to significantly speed up the inspection process compared to the currently available touch point method.

Saved analysis result: NX 10 enables you to use NX CMM to analyze measured results by bringing them back into the graphics system to compare against the as-modeled geometry. You can also compare subsequent measurements against previous measurements as manufacturing processes are refined and quality is improved.

**Line Designer**

Line Designer is a new application in NX 10 that provides manufacturing line design capabilities for automotive assembly manufacturing. The advanced parametric engine in NX enables you to easily design flexible layouts of production lines. You can also perform accurate impact analysis and drive efficient change management by using the parametric resources. The integrated Siemens PLM Software platform lets you use Teamcenter and Tecnomatix software to manage the designs, and validate and optimize manufacturing processes.

**Help and search**

NX 10 Help is now provided as a web application which allows you to more easily serve a single copy of the help to multiple users. The Help no longer requires Java applets and no longer breaks due to Java security updates. Search in the Help is also faster and includes more intuitive filtering options.

**Summary**

With the NX 10 release, we continue to look for innovative ways to deliver solutions that meet your product development and manufacturing challenges.
We are confident that our accomplishment of these objectives will enable you to extract the highest value from our solutions. For a complete overview of all enhancements and for additional information about this release, refer to these Release Notes as well as the What’s New Guide included with the NX 10 Help.

Sincerely,

Your NX 10 Team
## Contents

Welcome to NX 10 ................................................................. 2

### System Information ...................................................... 1-1
- Customer support .......................................................... 1-2
- Version up testing ......................................................... 1-3
- Platforms ................................................................. 1-3
  - System requirements guidelines .................................... 1-3
  - Operating system requirements ..................................... 1-5
  - Mac OS X Support ...................................................... 1-9
  - Linux graphics caveats ................................................. 1-13
  - Supported hardware and graphics .................................. 1-14
  - Initializing the JVM ................................................... 1-15
  - Antivirus caveats ..................................................... 1-16
  - NX variables in the ugi.env.dat file .............................. 1-17
- Browser requirements ................................................... 1-18
  - Browser and plug-in requirements ................................ 1-18
  - Browser caveats ...................................................... 1-20
- Licensing Caveats ....................................................... 1-21
  - General licensing caveats ......................................... 1-21
  - Licensing caveats for Windows .................................... 1-22
  - Licensing caveats for Linux ....................................... 1-23
  - Licensing caveats for Mac OS X .................................. 1-24
- Product compatibility - supported version combinations .... 1-26
- NX compatibility with Spreadsheet .................................. 1-28
- NX applications unsupported on specific platforms .......... 1-29
- Support for touch enabled devices ................................. 1-30

### Fundamentals ............................................................. 2-1
- Product Notes .......................................................... 2-2
- Caveats .................................................................. 2-3
- Documentation Notes .................................................. 2-5

### CAD ................................................................. 3-1
- Modeling ................................................................. 3-1
  - Product Notes ........................................................... 3-1
  - Caveats .................................................................. 3-2
- Drafting ................................................................. 3-2
  - Product Notes ........................................................... 3-2
  - Caveats .................................................................. 3-4
- Assemblies ............................................................... 3-5
  - Documentation Notes .................................................. 3-5
  - Product Notes ........................................................... 3-5
## Contents

Caveats ................................................................. 3-6
Visual Reporting ...................................................... 3-7
Caveats ................................................................. 3-7
Data Reuse .............................................................. 3-7
  Product Notes ....................................................... 3-7
Routing .................................................................. 3-8
  Product Notes ....................................................... 3-8
  Documentation Notes .............................................. 3-9
Caveats ................................................................. 3-10
Shipbuilding ........................................................... 3-10
Caveats ................................................................. 3-10
PMI .................................................................... 3-11
  Product Notes ....................................................... 3-11
Sheet Metal ........................................................... 3-12
Caveats ................................................................. 3-12

**CAM** .............................................................. 4-1

NX 10 Manufacturing Product Notes ............................... 4-1
  Manufacturing Product Notes .................................. 4-1
  CAM Early Adopter program .................................. 4-3
  Tool path and template changes ......................... 4-4
  Manufacturing critical maintenance and retirement notices 4-7
  General changes ................................................ 4-10
  Integrated Simulation and Verification (ISV) ............ 4-12
  Feature-based Machining (FBM) ............................ 4-14
Manufacturing caveats ........................................... 4-14
  General caveats ................................................ 4-14
  Milling caveats ................................................ 4-15
  ISV caveats ........................................................ 4-20
  Turning caveats ................................................ 4-22
  Manual drilling, Hole Milling, Thread Milling ........ 4-23
  Manufacturing documentation corrections .............. 4-23

**CAE** .............................................................. 5-1

Advanced Simulation ................................................ 5-1
  Caveats ............................................................... 5-1
  Documentation notes ........................................... 5-6
Motion Simulation ................................................ 5-6
  Caveats ............................................................... 5-6

**Programming Tools** ........................................... 6-1

**Inspection and validation** ....................................... 7-1

Check-Mate and Requirements Validation ....................... 7-1
  Caveats ............................................................... 7-1
CMM Inspection Programming ................................... 7-1
  Caveats ............................................................... 7-1
Tooling Design ................................................................. 8-1
  Weld Assistant .......................................................... 8-1
  Documentation Notes .................................................. 8-1
Electrode Design ................................................................ 8-2
Mold flow analysis ............................................................ 8-4
Context sensitive Help for Tooling Design ............................. 8-5
NX 10 Tooling Design, Motion Simulation documentation corrections and additions 8-5
  Run Simulation ............................................................. 8-5
  Run Simulation dialog box ............................................. 8-6
  Preprocess Motion ........................................................ 8-8
  Preprocess Motion dialog box ........................................ 8-9
  User Defined Motion ..................................................... 8-16
  User Defined Motion dialog box .................................... 8-17
  Define Cam .................................................................. 8-20
  Define Cam dialog box .................................................. 8-21
  Define Slide .................................................................. 8-24
  Define Slide dialog box .................................................. 8-25
  Define Lifter .................................................................. 8-29
  Define Lifter dialog box .................................................. 8-30
Progressive Die Support documentation corrections and additions 8-31
  Unfolding Simulation ...................................................... 8-31
  Unfolding Simulation dialog box ..................................... 8-33
  General Insert .............................................................. 8-37
  General Insert dialog box .............................................. 8-38
  Backing Pad .................................................................. 8-41
  Backing Pad dialog box .................................................. 8-42
  Slug Retention .............................................................. 8-44
  Slug Retention dialog box .............................................. 8-45
  Initialize Project dialog box corrections ............................ 8-47
  Manage Die Base dialog box corrections ......................... 8-48
  Force Calculation dialog box corrections ......................... 8-49
  Piercing Insert Design dialog box corrections ................. 8-50

Data translation ................................................................. 9-1
  Product Notes ............................................................... 9-2
  Caveats ....................................................................... 9-3

Teamcenter integration ......................................................... 10-1
  Product Notes ............................................................... 10-2
  Caveats ....................................................................... 10-3

Mechatronics Concept Designer ............................................. 11-1
  Product Notes ............................................................... 11-2

Line Designer .................................................................... 12-1
  Product notes ............................................................... 12-2
  Documentation notes ...................................................... 12-4
Chapter 1: System Information
Customer support

Customers covered by valid maintenance agreements are eligible to receive telephone and web support from the Global Technical Access Center (GTAC) on issues regarding any current or past release. We will always assist our customers to the best of our ability.

To report serious problems against supported releases, please contact your local GTAC support center http://support.industrysoftware.automation.siemens.com/services/global_number.pdf.

For additional information on GTAC services, visit our support pages at http://www.siemens.com/gtac and review our featured services.
Version up testing

Version up testing helps you to ensure that your existing data will version up smoothly to the latest release of NX. Along with our pre-release NX software, we provide an automated application that checks part features, drawings, and smart model data to make sure that they are compatible with the latest release of NX. You can use this application to test a large collection of data with minimum intervention. You can submit parts with detected problems for further evaluation by Siemens PLM Software by submitting problem reports through normal GTAC processes.

If you are interested in version up testing, refer to the following directories for the appropriate README files and associated utilities.

For feature modeling: .../ugsamples/update_all_features

For drawings: .../ugsamples/update_all_drawings

For smart models: .../ugsamples/update_all_smartmodels

Platforms

System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
Hidden line rendering
Closest approach
Faceting
Mass properties

SMP is enabled by default with the variable UGII_SMP_ENABLE, which is located in the ugii_env_ug.dat file.

Multi-Core

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is that this technology has proliferated much faster than SMP and is now common in workstations, servers, and laptops.

Multi-core technology is complex and, depending on the configuration, can actually have a negative impact on performance. This is due to the potential conflict of multiple cores sharing system resources, such as cache, memory, and bus bandwidth, as well the need for the system to manage and control an increasing number of cores. Increasing the number of cores does not always translate into better performance. Although additional cores can improve NX performance, processor speed is still a vital measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare performance with a different number of cores that are active. Some users may find that turning off some cores will actually improve performance. One micro-architecture (Intel) even does this automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the limitations of older multi-core technologies. New subsytems better integrate memory and other peripherals directly to the processors, resulting in major performance improvements. Buses are being eliminated, cores are better managed, and channel speeds continue to improve.

In summary:

- Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a slight overhead.
- Turn SMP on if you have a multi-core system.
- Never assume that by simply adding more cores you will see better performance. Always test first.

Memory

For Windows 7, the minimum amount of memory is 4 GB, but we recommend 8 GB or 16 GB of memory as a starting point. Large models and assemblies or running multiple processes concurrently could boost the required memory for adequate performance.
Graphics adapters

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

If you are running Microsoft Windows 7 you will require graphics adapters with more on-board memory, especially when AERO (the enhanced 3D feature) is turned on. The minimum recommended graphics on-board memory is 256 MB, and although graphics adapters with less memory will work, the performance may not be adequate, even with AERO turned off. If you have high-end graphics requirements, you will need to consider graphics adapters with 512 MB or higher on-board memory.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.

Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.

- NX 6.0.1 or higher - no older releases are supported.
- Two monitors only.
- LCD monitors only
- Run with native resolution and aspect ratio.
- Laptops are tested without docking stations or port replicators (direct connection only).
- Horizontal Scan mode (not Vertical) and only with identical monitors.
- Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

Operating system requirements

Operating system requirements

This section documents operating system and service pack requirements.
Minimum Certified Operating Systems

The following operating systems are certified and the minimum recommended for NX 10. Newer versions and service packs are certified as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (64-bit)</td>
<td>Microsoft Windows 7 Pro and Enterprise editions</td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 11 SP1</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux Server/Desktop 6.0</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Version 10.8.5</td>
</tr>
</tbody>
</table>

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 10. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 10 running on these operating systems. If NX 10 is deployed on these versions of Windows, any issues will have to be replicated on Windows 7 before filing an incident report with GTAC.

Considerations and caveats

End of support for NX 32-bit

The memory addressing limitations of 32-bit processing and the widespread deployment of 64-bit systems has pushed OS providers, hardware vendors, and application developers to migrate their products to the 64-bit version. As a result, NX 10 is available as 64-bit only and customers will need to migrate to the 64-bit version, if they have not already done so.

Today, 64-bit processors are used in desktops, laptops, and workstations whether for consumers, gamers, or enterprise environments. The server version of Windows 7 is already 64-bit with no available 32-bit version. Siemens PLM Software supported 64-bit starting with UNIX and supported only 64-bit on Linux and Mac OS.

Microsoft Windows 8 and 8.1

Windows 8 and 8.1 were certified with NX 8.5.2 and are supported for that version and all subsequent versions of NX including NX 10.

Microsoft Windows 7

NX supports Windows 7 64-bit only; NX does not support Windows 7 32-bit. NX supports the Windows 7 Professional and Enterprise editions only.

Windows 7 requires considerably more resources (memory, disk, and so on.) than Windows XP, so it may be necessary to increase memory or disk, upgrade your graphics adapter, or even replace your workstation, to achieve the same performance available under Windows XP.
Note

Siemens PLM Software recommends a minimum of 4 GB of memory and a graphics adapter with at least 256 MB of on-board memory, but 512 MB or higher for those with large or complex models.

Besides the expected increases caused by this new enhanced operating system, Windows 7 has some special features that can increase memory usage quickly. The 3D desktop, user interface, and graphics capabilities of Windows 7 differ dramatically from those of Windows XP (you must think of this as a new OS and not a WXP upgrade) and can consume considerable memory resources. In addition, although Windows 7 supports OpenGL similar to previous versions, other changes in Windows have impacted the way graphics vendors use system resources (like memory). For Windows 7, the recommendation is to either increase on-board graphics adapter memory, or increase system addressable memory, or both.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

Linux Requirements

NX supports SuSE Linux and well as Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 11 SP1 and Red Hat Enterprise (Desktop/Server) is 6.0. Newer versions will be supported via certification.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

Java Runtime Environment

Starting in NX 8.5, the Java Runtime Environment (JRE) is no longer shipped with NX. NX requires JRE 7 minimum for Windows and Linux; JRE 6 for the Mac. To install the JRE, visit the Java download site at http://java.com/en/download/index.jsp

Java is used for the following products:

• NX Relations Browser
• Product Template Studio
• Manufacturing – Process Studio Author
• Command line version of the following translators:
  o CATIA V4
  o CATIA V5
  o Dxfdwg
  o IGES
  o NX Pro E
  o Step AP203
• Step AP214

  Note

  The external user interface for the above translators requires JRE 8.

• Knowledge Fusion ICE

• Online Help

  Note

  NX 9.x and earlier versions contain a different Help Search that requires the latest version of the Java plugin installed as an Add On to the browser. NX 10 and later versions do not require the Java plugin for the Help Search.

• Quality Dashboard

• Validation Rule Editor

• Batch Mesher

• Customer written NX Open Java programs

• NX Response Simulation Function Tools

Java requirements for NX Open

NX Open for Java is designed to be used with Java version 1.8.0 or higher on Windows and Linux. The Java version for Mac OS X is 1.8.0.

Linux requires the 64-bit version of Java.

Post Processing of Abaqus ODB format results

In the NX 10 release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

  Note

  If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website: http://simulia.custhelp.com

For more information on the system requirements for ODB version 6.12 files, see: http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products

Configuration files

Starting with NX 10, the NX configuration files on Windows are written to C:\users\<name>\AppData\Local\Siemens.
Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.5. In addition, to replay a .NET journal, the .NET Framework 4.5 must be installed.

To download the .NET Framework 4.5, use the links on this page: Microsoft .NET Framework 4.5 (Web Installer).

Note

If you have installed Visual Studio 2012 SP1, then you have .NET Framework 4.5 installed by default.

Mac OS X Support

Hardware and installation requirements

Hardware and operating system requirements

The release of NX 10 on Mac OS X supports Apple Mac 64-bit Intel based systems. These include the MacBook Pro, iMac and Mac Pro systems. All available graphics subsystems are supported.

The minimum version of Mac OS X required to run NX 10 is version 10.8.5. Later versions of Mac OS X are also supported, but there may be caveats.

Installation of NX on Mac OS X is supported only on an HFS+ file system. However, NX part files and other data files may be stored and retrieved from an NFS file system.

X11/Motif requirements

NX 10 on Mac OS X utilizes X11/Motif to support its graphical user interface. Xquartz 2.7.5 and OpenMotif are required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.

OpenMotif must be installed prior to installing NX. Obtain the OpenMotif toolkit, openmotifcompat-2.1.32_IST.macosx10.5.dmg, from the following website:

http://www.ist-inc.com/DOWNLOADS/motif_download.html

The X11 application must be running while using NX. The X11 application is started when NX or any other X-based application is invoked.

Installation

Installation must be performed from an account with administrator privileges and must be performed on a Mac since it uses the Mac OS X Installer application.

To install, double-click the nx.10.*.mpkg file and follow the instructions presented in the installation dialog box.

Note

If the .mpkg file has a .tar.Z or .zip extension, then it is compressed. You must first double-click it to uncompress it and create the .mpkg file.
Additionally, install the online documentation by double-clicking the *ugdoc.10.*.pkg file and following the instructions.

Optionally, install the license server by double-clicking the *ugslicensing.*.pkg file and following the instructions. The license server will be needed if you are installing NX on a system, such as a laptop, that is not connected to a network.

**Product notes**

**Mouse focus policies**

The X11 mouse focus policy specifies how the mouse advises X11 on which window is active and can receive keystrokes. The **Click-through Inactive Windows** and **Focus Follows Mouse** operations are often preferred to the X11 defaults.

In the X11 bundle of Lion, the mouse focus policies are set by choosing X11→Preferences, Windows tab. The Windows tab contains the following options:

- **Click-through Inactive Windows**
- **Focus Follows Mouse**
- **Focus On New Windows**

You must restart X11 for a change to take effect. Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the quartz-wm man page for details.

**Pasteboard/Clipboard Setup**

The X11 Pasteboard policy defines how the Mac OS Pasteboard communicates with the X11 CLIPBOARD. To ensure proper clipboard copy/paste behavior in NX, syncing between the Mac OS Pasteboard and X11 CLIPBOARD should be disabled.

In the X11 bundle of Lion, the Pasteboard policies are set by choosing X11→Preferences, Pasteboard tab. Uncheck the Enable syncing option.

Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the quartz-wm man page for details.

**3D Input Devices**

Support for 3Dconnexion input devices is available for NX on Mac OS X through the use of drivers and software available directly from 3Dconnexion. Use the following link to download the software and get installation information.

[http://www.3dconnexion.com/service/drivers.html](http://www.3dconnexion.com/service/drivers.html)

**Plotting**

MAC OS X printing systems handle PDF files in native mode. NX Plotting takes advantage of this by creating a PDF file which it hands off to a Macintosh application that handles the printing task. Because these native tools can interface with the printing system, the usual SDI plotting software used with other platforms is not used on MAC OS X.
Teamcenter Integration support for Mac OS X

Teamcenter Integration (TCIN) is supported on the Mac platform when you run in a four-tier environment. The operation and functionality of Teamcenter Integration on the Mac platform is the same as on other platforms.

Note

The Teamcenter two-tier environment is not supported.

The Mac client setup in a four-tier Teamcenter environment is similar to the setup for Linux. However, you have to install the Mac client as a TCCS installation instead of an FMS installation. Typically, the TCCS install is done as part of the RAC TC install, but since the Teamcenter RAC install does not support the Mac platform, the TCCS standalone installer needs to be used. This installer is provided on the Teamcenter Mac DVD or Mac install download. For install and setup information, see the Teamcenter installation documentation.

After installation is complete, you can create a script to setup TCIN for use before launching NX. The following is a sample script:

Note

- The values and paths used here are for example only. Use the values and paths that are applicable for your site.
- The line:

  defaults write com.siemens.plm.nx10 PIM Yes

  sets the -pim option to Yes. You can set this back to No to run native NX.
- You do not set the user name (-u) and password (-p) options in the script. You enter these in the dialog box that is displayed when you run NX.

Sample script:

  defaults write com.siemens.plm.nx10 FMS_HOME /home/UGS/Teamcenter/Tc10/tccs
  defaults write com.siemens.plm.nx10 UGI__UGMGR_HTTP_URL http://annpc38:7001/tc/aiws/aiwebservice
  defaults write com.siemens.plm.nx10 PIM Yes
  defaults write com.siemens.plm.nx10 JAVA_HOME /System/JavaVM.framework/Versions/1.5/Home
  defaults read com.siemens.plm.nx10 FMS_HOME=/home/UGS/Teamcenter/Tc10/tccs; export FMS_HOME
  JAVA_HOME=/System/Library/Frameworks/JavaVM.framework/Versions/Current/Commands/java_home; export JAVA_HOME

Caveats

Mac OS X 10.8

If you are using Mac OS X version 10.8 (Mountain Lion), the minimum supported version for NX 10 is version 10.8.5. Apple's release of Mountain Lion (Mac OS X 10.8) no longer includes the X11 libraries required by NX.

Xquartz 2.7.5 and OpenMotif are required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11—Check for X11 Updates.... dialog box.
CAE

NX 10 on Mac OS X does not support any CAE functionality. CAE modules and specialized NX functions that depend on CAE are not supported.

Plotting

Plotting of high quality images using the View→Visualization→High Quality Image command does not work.

Relations Browser

The relations browser is not supported. When you choose Assemblies→WAVE→Relations Browser, the command does not work.

Spreadsheet support

NX 10 on Mac OS X does not support the use of any spreadsheet.

Enabling the Alt key

When you use NX, the Alt key can be very handy. The Mac OS does not automatically enable the Alt key for use with NX. You have to update the X server's keyboard mapping.

Redefine the key on the keyboard

To enable the Alt key, you need to update the keyboard mapping to redefine the key labeled alt/option. Enter the following command in a Terminal window:

```
defaults write org.x.X11 option_sends_alt -boolean true
```

The alt/option key now sends Alt_L and Alt_R instead of Mode_switch.
Linux graphics caveats

Some applications experience a severe X server crash with Red Hat 6.0 (and later) and SuSE 11.x. The crash of the server causes the user to exit the login session. When this occurs, the user must login again. This problem has only been seen on nVidia graphics boards. If you are using an older driver, the first recommendation is to try the latest graphics driver. If this problem is observed in other applications, the following workaround can be applied.

Note

Use this workaround only if you experience the problem, as it can cause a performance slowdown. To work around this problem, modify /etc/X11/xorg.conf and add the following line to the Device section for nVidia after the Driver line.

Option "UseCompositeWrapper" "true"

Thus, after the change, the device entry in xorg.conf might look like:

```
Section "Device"
  Identifier "Videocard0"
  Driver "nvidia"
  Option "UseCompositeWrapper" "true"
EndSection
```

You must login as root in order to make this change. It is prudent to make a backup copy of /etc/X11/xorg.conf before making this change. Each time the nVidia driver (the same or a newer version) is installed, you need to take the above steps to ensure the Option line is included. In order for the change to take effect, you must restart the X server by either rebooting or pressing Ctrl+Alt+Backspace (if you are in a live X session).

Note

With some AMD configurations on Red Hat and SuSE, a different problem has been observed whose similarity with the problem seen with the nVidia configuration may cause you to believe it is the same problem. This problem causes NX and many X applications to fail with a segmentation violation or a memory fault at the start. However, this problem is likely due to the AMD graphics driver not being configured correctly. The simple solution to this problem is to do the following:

1. Login as root

2. Make a backup copy of /etc/X11/xorg.conf.

3. Remove /etc/X11/xorg.conf.

4. Regenerate a new xorg.conf by running the command:
   ```
   aticonfig --initial
   ```

5. Restart the X server.
**Supported hardware and graphics**

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at [Hardware and Software Certification → Hardware (Graphics Card) Certifications](#). This opens a spreadsheet that has tabs for supported systems and graphics.
Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

Starting in NX 8, if NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free
=================================
Maximum block 267Mb
=================================
Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on.
Otherwise your other option is to use Remoting. Please consult the NX Open Programmer’s Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the –Xmx and –Xms options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine’s current memory load. For example:

UGII_JVM_OPTIONS=–Xmx=50M –Xms=50M

When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the ugi.env.dat file so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX session.
Antivirus caveats

Avira

The Avira antivirus program on Windows platforms may incorrectly identify some NX DLL files as contaminated with a virus. To prevent this problem, use the Avira option to exempt the files from virus scanning.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env_ug.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>\ugii.

Note

You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

- Define the variables before the #include statement.

- The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

  Note

  This also applies to the ugii_env_ug.dat file.

- You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

    UGII_ENV_FILE=G:\common\ugii_env.dat

  Note

  The file must be named ugii_env.dat.

Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

- #if/#else/#endif

  Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:

  - FILE - Check for the existence of a file

    #if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
#else
UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
#endif

- **platform** - Check for a specific platform. Possible values:
  - x64wnt
  - ix86wnt
  - lnx64
  - macosx

- **$variable = “value”** - Check for a specific value for a previously defined environment variable

- **$variable != “value”** - Check for a previously defined environment variable that does not have the specified value.

  - #include
    Used to include a specified environment file at the current location

    #include $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat

**Browser requirements**

**Browser and plug-in requirements**

The NX suite of documentation (Help, What's new Guide, and Release Notes) is Learning Advantage courses are provided in an HTML format that is displayed in your local Web browser.

**Windows browser support**

- Internet Explorer 9, 10, and 11 (Windows 7)
  - Internet Explorer 10 and 11 (Windows 8)

  If you have problems displaying the pages in Internet Explorer, you may need to set your browser options to allow active content to be displayed.

  To allow active content to be displayed in Internet Explorer, follow these steps:
1. Select **Tools**→**Internet Options**.

2. Click the **Advanced** tab.

3. In the **Security** section, turn on **Allow active content to run in files on My Computer**.

   - Mozilla Firefox 21 or higher
   - Google Chrome 28 or higher

**Linux browser support**

   - Mozilla Firefox 21.0 or higher

   If you have other Mozilla web browsers installed on your system, make sure either your default browser is set to the correct Firefox version, or the UGII_HTML_BROWSER environment variable in your *ugii_env.dat* file is set to the supported Firefox version.

**Mac OS X browser support**

   - Safari 5.x or higher
   - Google Chrome 28 or higher

**Downloading browsers**

These browsers are free and can be downloaded from the following Web sites:

   - **Internet Explorer** — http://www.microsoft.com
   - **Firefox** — http://www.mozilla.org
   - **Safari** — http://www.apple.com

**Windows .chm files**

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.

**Flash required for videos**

To watch videos and simulations, you must have the Adobe Flash Player version 10 or later installed as a plug-in to your browser. You can download the Flash Player (free) at the Adobe Flash Player site.

**Adobe Acrobat Reader**

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from http://get.adobe.com/reader/.
Browser caveats

Browser caveats for Internet Explorer

IE9 compatibility view. The HTML Help is fully supported when launched with the http:// protocol or the file:// protocol. However, if you are viewing an older version of the Help from a local installation, such as D://, you may need to enable the Compatibility View. In IE 9, perform the following:

2. In the Compatibility View Settings dialog box, select Display all websites in Compatibility View.

Browser caveats for Firefox

- Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.
- The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.
- Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file://), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:
  1. In the address bar, type about:config.
  2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.
  3. Restart the browser.
- If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.
Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

• Merging of license files is not supported.

  Example

  You cannot merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the uglmd license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the ugsldm daemon.

  NX 10 requires and tests for the latest version of the ugsldm vendor daemon. This vendor daemon is supplied with NX 10 and must be installed and initiated prior to starting NX 10. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

• The SPLM License server install requires that Java 1.5+ is installed on the system.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 10 borrowing tool will work for NX 10 but cannot be used to run NX 9. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.

Licensing Guides

Refer to the NX 10 software DVD for the most recent version of the various licensing, administration and server installation guides. The licensing guides included in the NX 10 Help are outdated and should not be used.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The License Option tool should only be used to borrow NX licenses, even though it may display other licenses. The License Option tool does not filter features in the license file that are of an earlier version than NX 10, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. Attempting to borrow a license other than NX 10 causes an error in the License Option tool.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

- LSB 3.0
Licensing caveats for Mac OS X

License server preference settings

The license server used by NX is specified during NX installation, but it may be necessary to view or change the license server setting after installation. To do that, open a Terminal window and use the following commands.

- To read the current license setting:
  
  ```
  defaults read /Library/Preferences/com.siemens.plm.nx10
  ```

  This command will show the current setting. For example “SPLM_LICENSE_SERVER” = “28000@myserver.mycompany.com”

- To change the license setting:
  
  ```
  defaults write /Library/Preferences/com.siemens.plm.nx9 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com
  ```

  You may need to use “sudo” if the Preferences file is writeable only by an administrator. For example
  
  ```
  sudo defaults write /Library/Preferences/com.siemens.plm.nx9 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com
  ```

  You do not need to restart the machine after setting the NX preference.

License server naming on Mac OS X

Mac OS X is different from many other operating systems due to the fact that when the networking conditions change, the hostname of a Mac workstation will change.

For example, while on the network (<mysite>.com), the hostname is `mac1.<mysite>.com`. While disconnected from all networks, the hostname changes to `mac1.local`. FLEXnet relies on the use of the hostname to locate the server so this hostname change causes the license server daemons to lose communication and prevents the client application from connecting to the license server. The result is an NX startup error caused by the inability to get a license.

This condition usually occurs when a single user on a laptop installs the license server and NX on the same laptop.

Use one of the following recommendations to help prevent or resolve this situation:

- Install a license server on a workstation or system that has a stable domain. It is recommended that a central license server be used for all client applications.

- Use the local IP address (127.0.0.1) for the hostname as follows.
  
  Change the file from:
  
  ```
  SERVER Yourhostname COMPOSITE=a1234567890b 28000
  ```

  To:
When asked for the license server value during the client application install, provide the following:

28000@127.0.0.1

- Request a standalone non-served license file. These license files do not need a license server but simply need to have the application point to a file. These license files are ideal for a user with only one seat of an application that is to be installed on a laptop. Contact your customer service representative for a standalone license file.

Common licensing tool on Mac OS X

The Common Licensing Tool (CLT) for Mac OS X is a licensing utility that enables the user to select bundles and borrow licenses.

Bundle selection

The interface to the Bundle Selection in the CLT for Mac is essentially the same as in the License Options application on Windows.

In order to select a bundle, you highlight the bundle in the Available Bundle list and click the Add button, or double click the selected item. The item is moved to the Selected Bundle list.

To remove an item from the Selected Bundle list and return it to the Available Bundle list, you can highlight the bundle you wish to return to the Available Bundle list and click the Remove button. Alternatively, you can double click the bundle to remove it from the Selected Bundle list.

No bundles are actually applied until you click OK. When you click OK, the modifications to the selected bundle list are written to a file in the user’s home directory, called splms_cl.reg.

The CLT for Mac allows for product-specification in the bundle settings. Thus, the name of the key for the bundle value is <PRODUCT>_BUNDLES, where <PRODUCT> is the product in question (such as NX, in which case the key would be NX_BUNDLES).

Borrowing

Borrowing with the CLT is similar to borrowing with License Options for Windows. To borrow a license feature or features, you select the features that you want and then choose the return date and time. Then you click the Borrow License(s) button. Finally, to perform the actual communication with the license server and borrow the selected items, click OK.

To return a borrowed license, you select the item you want to return, click the Return License(s) button, and then click OK.

The Reset button will cause all Return Dates to go back to the original state they were in when you initially launched the tool. Thus, items that were not borrowed will have their return dates cleared, and any items that had the return date changed or cleared will be reset to their original value when the tool was launched.
## Product compatibility - supported version combinations

### Teamcenter and NX

The following table lists which version combinations of Teamcenter and NX are supported.

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>NX 7.5</th>
<th>NX 8.0.x</th>
<th>NX 8.5</th>
<th>NX 8.5.x</th>
<th>NX 9</th>
<th>NX 9.0.x</th>
<th>NX 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1)</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.1</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(2)</td>
</tr>
<tr>
<td>8.3</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>(3)</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(4)</td>
</tr>
<tr>
<td>9.1</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>(4)</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>(10)</td>
</tr>
<tr>
<td>10.1</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td>(11)</td>
</tr>
</tbody>
</table>

(1) Only Teamcenter UA 2007.2.0.2 or higher.

(2) Only Teamcenter UA 8.1.0.2 or higher.

(3) NX 7.5.4 MP2 or higher.

(4) NX 7.5.5 MP2 or higher.

(5) Compatible with Teamcenter UA 8.3.0.2 or higher. Recommended Teamcenter UA 8.3.3.4 or higher.

(6) NX 8.0.2 or higher.

(7) Only Teamcenter UA 8.3.3.5 or higher.

(8) Only Teamcenter UA 9.1.2 or higher.

(9) Only Teamcenter UA 8.3.3.6 or higher.
(10) Only Teamcenter UA 10.0.0.1 or higher.
(11) NX 8.5.2 MP1 or higher with Teamcenter UA 10.1.0.1 or higher.
(12) Only Teamcenter UA 9.1.2.4 or higher.
(13) Only Teamcenter UA 10.1.0.1 or higher.
(14) For NX 9.0.2, Active Workspace 2.1. For NX 9.0.3, Active Workspace 2.2.
(15) Only Teamcenter UA 10.1.2.2 or higher.
(16) Active Workspace 2.2

Note

For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.
# NX compatibility with Spreadsheet

<table>
<thead>
<tr>
<th>NX version</th>
<th>Platform</th>
<th>Spreadsheet Software version</th>
<th>Windows</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 8 64-bit</td>
<td>Windows 7 64-bit</td>
<td>8 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Certified &amp; supported</td>
</tr>
<tr>
<td>Windows 7 64-bit</td>
<td>Linux 64-bit</td>
<td>Suse Enterprise 11 SP1</td>
<td>Supported</td>
<td>Certified &amp; supported</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>Linux 64-bit</td>
<td>Red Hat Enterprise V6</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

**Note**

- The NX spreadsheet interface is not supported on the MAC platform in NX 10.
- The 64-bit versions of Microsoft Excel are not yet supported by NX. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.
- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.
- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).
- If you launch a spreadsheet command such as **Spreadsheet** or **Part Family** on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.
**NX applications unsupported on specific platforms**

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>File Print</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>File Open of SolidWorks files</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Advanced Studio Rendering Style Mode</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Plotting</td>
<td>Plotting of high quality images using the <code>View → Visualization → High Quality Image</code> command</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Manufacturing Milling</td>
<td>Siemens 840D virtual machine tool controller (VNCK)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Manufacturing Wizard Builder (part of Simulation Process Studio)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Design Simulation (CAE)</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>Advanced Simulation and Design Simulation Abaqus OBD result file reading</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Motion Simulation Mechatronics co-simulation with RecurDyn solver</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Teamcenter Integration</td>
<td>Launching NX from Active Workspace web client</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Human Modeling</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>Automatic creation of ESC solution</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>CR5000 pcb files Import / Export / Compare (PCB Exchange for Zuken limitation)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Mechatronics Concept Designer</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Simple NX Application Programming (SNAP)</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 10, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

• Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.

• Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.

• Any issue determined to be caused by the graphics driver is not supported.

• Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

• NX supports touch devices on both Windows 7 and Windows 8 operating system.

• Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros and the Perceptive Pixel configurations.
Chapter 2: Fundamentals
Product Notes

Retirement of Classic Toolbar User Interface from the Windows platform

The choice for a Classic Toolbar user interface on Windows will be removed in NX 11. In order to ease your transition from toolbars to ribbon, NX 9 and NX 10 give you a choice of Ribbon Bar or Classic Toolbar mode for your user interface. This choice will be removed in NX 11 and the Ribbon Bar will be the only user interface choice on Windows. The Ribbon Bar was implemented in NX 9 and provides access to more commands than the Advanced role in Classic Toolbar mode with a larger graphics window. And it does all this with logical groupings, informative text and a mixture of icon sizes. In addition to these traditional aspects of the Ribbon Bar, the NX ribbon is fully customizable and contains NX-specific extensions such as border bars. The result is a more organized user interface with the richness of Advanced and the discoverability of Essentials.

For instructions on how to migrate from Classic interface to Ribbon bar interface, see NX Ribbon-Customization and Transition.
Caveats

File New dialog not localized

The File New dialog Tab names and template names will display in English no matter what runtime language is set by the UGII_LANG variable.

Bookmarks

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode will not be in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when
1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.

Pixel Widths settings

If you open a part that was last saved in any release before NX 8.5 and then use the Edit Object Display command to modify the width of an object, the pixel width applied to the object might appear thinner than you expect.

If the display of line width is unsatisfactory, use the Pixel Widths settings to change the pixel width assigned to the line.

• You can change Pixel Widths settings of the currently displayed part on the Line tab of the Visualization Preferences dialog box.

• To change Pixel Widths settings of all pre-NX 8.5 parts and of new parts created using the Blank template, change the default Pixel Widths settings on the Line tab in Customer Defaults dialog box→Gateway→Visualization.

Using Ray Traced Studio on NVIDIA devices

To render images using the Ray Traced Studio command with acceleration in NX, on NVIDIA devices, you need to install the UGPHOTO directory on a path without a space. You also need to reset the following environment variables accordingly:

• UGII_LI_TOP

• UGII_LI_LAYLA_DIR

• UGII_RENDER_ARTISTIC_DIR

• UGII_SHOWROOM_DATA_DIR

• UGII_CANNED_MATERIAL_DIR
• UGII_HDR_IMAGE_DIR
• UGII_ENV_IMAGE_DIR
• UGII_SYSTEM_SCENE_DATA_DIR
• UGII_TRUESHADING_DIR

Please see ugii_env_wnt.dat for more information.

For a standard installation in the C:\program files(x86)\... location, you may not get acceleration when you use the Ray Traced Studio command. The workaround is to move UGPHOTO to a path without a space and reset the relevant UGII_environment variables.

**Example**

If you move UGPHOTO to C:\workdir\UGPHOTO, then you need to set the following environment variables as shown:

• UGII_LI_TOP=C:\workdir\UGPHOTO\ray_traced_studio
• UGII_LI_LAYLA_DIR=C:\workdir\UGPHOTO
• UGII_RENDER_ARTISTIC_DIR=C:\workdir\UGPHOTO\artistic_render\n• UGII_SHOWROOM_DATA_DIR=C:\workdir\UGPHOTO\ug_environment
• UGII_CANNED_MATERIAL_DIR=C:\workdir\UGPHOTO\ug_canned_mattex
• UGII_HDR_IMAGE_DIR=C:\workdir\UGPHOTO\hdr_images\n• UGII_ENV_IMAGE_DIR=C:\workdir\UGPHOTO\env_images\n• UGII_SYSTEM_SCENE_DATA_DIR=C:\workdir\UGPHOTO\system_scene_data_dir
• UGII_TRUESHADING_DIR=C:\workdir\UGPHOTO\true_shading

**Interoperation request in Windows**

In the Windows operating system, when NX receives an interoperation request, the NX application will not be raised in front of other running applications.

Interoperation requests occur when you send a part from Teamcenter to NX or when you double-click a part in the Windows Explorer. Newly started NX sessions would still appear at the front.

**Using Teamcenter as the issue site for NX Issue Management**

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.
Documentation Notes

Visualization Performance Preferences dialog box

The location of the Facet Cache Memory option is revised.

<table>
<thead>
<tr>
<th>Command Finder</th>
<th>Visualization Performance Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location in dialog box</td>
<td>General Graphics tab:</td>
</tr>
<tr>
<td></td>
<td>Session Settings group→Shaded Views sub group →Facet Cache Memory</td>
</tr>
</tbody>
</table>
Chapter 3: CAD

Modeling

Product Notes

History-Free Mode

After careful consideration and extensive research we have decided to stop offering History-Free Mode in NX. We have many reasons to believe that using History Mode offers a more complete and compelling solution. Our experience has shown us that the vast majority of you are making use of the power of Synchronous Technology in History Mode and we will continue our focus in that area. Over time we will consider implementing the small number of unique History-Free capabilities in History Mode.

History-Free Mode will be retired in the NX 11 release. As part of this plan, creating a History-Free part or converting a History part to a History-Free part will no longer be supported. History-Free parts created prior to the NX 11 release will continue to be supported. You will be able to open these parts in NX 11, and they will continue to work in History-Free Mode.

Trim Sheet

In addition to receiving functional enhancements in NX 10 the Trimmed Sheet command has been renamed to Trim Sheet. Legacy Trimmed Sheet features will be renamed to Trim Sheet. Custom programs that use the feature name Trimmed Sheet will need to be updated to Trim Sheet.

Spline (to be retired)

The legacy Spline command is to be retired in a future release of NX and is now hidden. It is recommended that you use the Studio Spline command instead. Until it is retired you have the option to bring the legacy Spline command back to NX under its new name, Spline (to be retired), using the Customize command.
Caveats

Assigning materials to NX parts

Beginning in Teamcenter 10.1, the Teamcenter Reuse Library is enhanced to let you define materials and make them available. However, you cannot yet assign materials to NX parts using this method. If you want to assign materials to NX parts such as part family members, you can use your user or site material libraries.

Facet Modeling

The following Facet Modeling commands handle simple data cases only:

- Extrude Facet Body
- Merge Disjoint Facet Bodies
- Merge Overlapping Facet Bodies
- Merge Touching Facet Bodies

Support for more complex data cases will be available in a future release of NX.

PMI Dimensions associated with a Hole feature

An error may result when deleting a PMI dimension associated with a Hole feature. This issue will be fixed in IP 19.

Drafting

Product Notes

Dragging while creating dimensions

Enhancements to the Drafting and PMI user interface give you the ability to relocate a dimension, and other annotations, while creating the dimension. You can move the dimension, or other annotation, after it is initially placed and no other objects have been selected for dimensioning.

Keyboard shortcuts for appending text to dimensions

While creating or editing dimensions, you can use the Ctrl+Arrow keys to navigate to the individual Appended Text on-screen input boxes.

<table>
<thead>
<tr>
<th>Use these control keys:</th>
<th>To access this Appended Text input box:</th>
</tr>
</thead>
</table>

NX 10.0 Release Notes
<table>
<thead>
<tr>
<th>Ctrl+Left arrow</th>
<th>Ctrl+Up arrow</th>
<th>Ctrl+Right arrow</th>
<th>Ctrl+Down arrow</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td><img src="image2.png" alt="Diagram" /></td>
<td><img src="image3.png" alt="Diagram" /></td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
Caveats

Crosshatch associativity

If the boundary curves of a crosshatch pattern are sketch curves, and the sketch curves are dragged on the drawing sheet, the crosshatch pattern may become retained. To reassociate the crosshatch pattern, right-click the pattern, select Edit, and then click OK.
Documentation Notes

Populate Title Block command in a drawing template

The Populate Title Block command is not available from the shortcut menu when working in a drawing template. A drawing template is created by using the Mark as Template command.

If you want to use the Populate Title Block command to edit the contents of a title block in a drawing template, you must specifically choose Drafting Tools tab→Drawing Format→Populate Title Block

Or you can double-click the title block to open the Edit Definition dialog box, and then click the Edit Table button to edit the contents of the title block.

Assemblies

Product Notes

Update Structure on Expand

The Update Structure on Expand customer default check box is now selected by default. This ensures that you see an up-to-date assembly structure when you expand unloaded subassembly nodes in the Assembly Navigator.

Note

The update that occurs when you expand an unloaded subassembly with Update Structure on Expand selected can cause a small delay. You may therefore notice that some assemblies need a little more time to expand than in previous NX releases, when the Update Structure on Expand customer default was not selected. If you clear the Update Structure on Expand check box, the performance may improve; however, you then risk displaying an out-of-date or incorrectly-configured assembly structure if the expanded subassembly is not loaded.

Using Make Unique when the original part has unsaved changes

Underlying parts must always be in sync with parts in Teamcenter. Therefore, you cannot use the Make Unique command to create a unique component from a part that has unsaved changes. You will receive a message that gives you the following choices:

Yes — Save Saves the changes to the original part without canceling the Make Unique command. You can now create the unique component.

Cancel Cancels the Make Unique command. The unsaved changes in the original part are not affected; you can save, modify, or discard them as necessary.

A third choice, No — Discard Changes, which let you discard the changes in the original part and create a unique component that included the changes, is no longer available. A unique component must be in sync to the original component when it is created. After you create the unique component, you can modify it.

Note

This change applies to NX 8.0.3 as well as NX 8.5 and subsequent releases.
Caveats

Move Component

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX ignores this setting if the displayed part or any of its subassemblies contain any component patterns. When you move components in this situation, the Move Component command behaves as though the Move Component Scope customer default is set to Work Part Only.

Sequencing

When a subassembly of the displayed part contains a component pattern, inserting a motion step in your sequence that affects a member of the component pattern may cause incorrect movement of the following:

- Members of the component pattern.
- Components directly constrained to the pattern members.
- Components indirectly constrained to the pattern members.

When component patterns are present only in the displayed part, the Insert Motion command works correctly.

Component Patterns

The following caveats apply to component patterns, which replaced component arrays in NX 9.0.

Position overrides When the position of component pattern members are overridden in a higher-level assembly, edits to their positions in the higher-level assembly may result in the components being incorrectly positioned. This can occur when the assembly that contains the pattern is not positioned at the origin of its parent assembly.

Selecting geometry for the pattern direction When you create or edit component patterns, you can define a direction by selecting geometry only when the selected geometry is in either the work part or in a component that is an immediate child of the work part.

In NX 9.0.1 and later releases, you can also use geometry selected from components that are further down the assembly structure of the work part. However, the direction definition is not associative unless the selected geometry is in the work part or one of its immediate children.

Performance of very large component patterns NX may be slow when creating very large component patterns, typically patterns with thousands of members. In most cases, you can improve the performance by ensuring that the Dynamic Positioning check box on the Pattern Component dialog box is not selected when you create the pattern.

Reordering in the Assembly Navigator

When the active order in the Assembly Navigator is the Alphanumeric order or the Alphabetic order, you can use the Reorder Components dialog box only when the navigator is sorted by the first column. If the navigator is sorted by any other column while the Alphanumeric order or the
Alphabetic order is active, you can reorder components only by dragging. This creates a new user-defined order.

This limitation exists only with the Alphanumeric order and the Alphabetic order. When any other order is active, you can reorder components using the Reorder Components dialog box regardless of which column is used to sort the navigator.

**Visual Reporting**

**Caveats**

**Density reports**

When you generate a report using the Body Density report property, it is possible for the report to return a value of 0.0000. This can occur because the default unit for Body Density is kg/mm$^3$, and the body density of most materials is less than 0.00001 kg/mm$^3$.

There are two options that can be used to work around the display issue:

- Select Preferences→User Interface to change the General→Displayed Decimal Places→Dialog Box setting from 4 to 9.

- Select Analysis→Units Custom→Units Manager to change the Measure→Mass Density setting from kg/mm$^3$ to kg/m$^3$.

For example, the density of a steel component could be displayed as 0.000007831 kg/mm$^3$ if the Displayed Decimal Places preference is set to 9. If the Mass Density is set to kg/m$^3$, the density would be displayed as 7831.

**Data Reuse**

**Product Notes**

**Index Search Server Installation**

The Reuse Library index search makes use of the Solr search engine. You will need to install SPLMDOCSERVER to start the Solr search engine. This will run as a service, Siemens PLM Documentation Server, which will be automatically started when the system reboots.

You can find the SPLMDOCSERVER and installation guide from the NX DVD.
Routing

Product Notes

Automatic fix constraint on Stock Offset Ports

In NX 9.0.2 and higher, NX adds an automatic fix constraint to every Stock Offset Port component to keep the component from moving when you connect a segment to the offset port.

This constraint is called Offset Constraint in Assembly Navigator and Constraint Navigator. If you change the name, NX reverts to the original name when the automatic fix constraint is recreated.

If you suppress the constraint, the component is free to move till you unsuppress the constraint.

If you add a new fix constraint, NX deletes the automatic fix constraint. If you delete the fix constraint that you added, NX again creates an automatic fix constraint.

You cannot move a Stock Offset Port component while editing an existing constraint using the Assembly Constraints dialog box. You can move a Stock Offset Port component while creating a new constraint using the Assembly Constraints dialog box. You can move or transform a Stock Offset Port component using the Move Component or Transform Path command if the only fix constraint on the component is the automatic fix constraint.

In case of conflicts with other constraints, NX displays a warning. In order to resolve such conflicts, you can remove or suppress the constraints that you have created or you can suppress the automatic fix constraint.

Installing standard parts to Classification in Teamcenter Engineering TC9.1

You can install standard parts to Classification in Teamcenter Engineering TC 9.1 by using the Classification Install for Part Library tool provided in the following folder:

UGII_BASE_DIR\ugroute_mech\classification_tool
Documentation Notes

Structure of a PTB file

The topic Structure of a PTB file erroneously states that NX uses the descriptor characteristics in the list of table columns in a PTB file to search for parts in the Routing Reuse Search dialog box. In reality, NX only displays the characteristics in the Routing Reuse Search dialog box. The switch /HIDE indicates that you do not want NX to show the characteristic in the Routing Reuse Search dialog box during part placement.

Note that the destination characteristics defined under specific disciplines in the APV file are used when you search for parts. This is not necessarily the same as what is displayed.

Unify Path enhancement

In previous releases, NX did not unify paths when direct mount parts or eccentric segments were a part of your selection. Parts that were placed using the Instance Name Lookup command and which were part of a run were ignored when you used the Unify Path command.

In NX 9.0.2 and later, in addition to the conditions mentioned above, NX does not unify a path that has an eccentric reducer part or any other routing part which has the NX_BLOCK_UNIFY attribute set to TRUE in the respective PTB file.

Parts which are placed using the Instance Name Lookup command are now ignored when you use the Unify Path command, even when the parts are not part of a run.
Caveats

Opening pre-NX 10 parts in NX 10

Opening pre-NX 10 parts might take longer when you open the part for the first time in NX 10.

Upgrade Stocks command

When using the Upgrade Stocks command on a part that uses Stock As Components and that has multiple levels of Routing assemblies, we recommend that you select the Work Part and Loaded Children Parts check box.

Color bleeding in harness displays

If the color bleeds through in the display of harnesses, use the Refinement Factor visualization preference to correct the display. The factor you must set varies depending on the part that is open.

In the Visualization Preferences dialog box→Faceting tab→Part Settings group, use the:

- **Shaded Views** subgroup→**Refinement Factor** option to adjust the display in a shaded view.
- **Advanced Visualization Views** subgroup→**Refinement Factor** option to adjust the display in advanced studio views.

Teamcenter Classification

The Teamcenter Classification plug-in is now obsolete. You can use the out-of-the-box support for classification by setting the Teamcenter classification options in the Part Library customer defaults.

**Tip**

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.

You can use the Reuse Library for classification without setting up additional plug-ins.

Shipbuilding

Caveats

Display Solid

Using the solid body displayed when using the Display Solid command in the Ship Structure Basic Design application may cause problems.
PMI

Product Notes

Dragging while creating dimensions

Enhancements to the Drafting and PMI user interface give you the ability to relocate a dimension, and other annotations, while creating the dimension. You can move the dimension, or other annotation, after it is initially placed and no other objects have been selected for dimensioning.

Keyboard shortcuts for appending text to dimensions

While creating or editing dimensions, you can use the Ctrl+Arrow keys to navigate to the individual Appended Text on-screen input boxes.

<table>
<thead>
<tr>
<th>Use these control keys:</th>
<th>To access this appended text box:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Left arrow</td>
<td>![Left arrow image]</td>
</tr>
<tr>
<td>Ctrl+Up arrow</td>
<td>![Up arrow image]</td>
</tr>
<tr>
<td>Ctrl+Right arrow</td>
<td>![Right arrow image]</td>
</tr>
<tr>
<td>Ctrl+Down arrow</td>
<td>![Down arrow image]</td>
</tr>
</tbody>
</table>
Sheet Metal

Caveats

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

Mirroring lofted flange feature with dependent features

Mirroring lofted flanges that have dependent features may give incorrect results for legacy (pre-NX 9) sheet metal parts. You must recreate the Lofted Flange feature in NX 9 or later release.

Unite in Sheet Metal

When you unite Sheet Metal bodies:

- If the target and tool bodies are not positioned correctly, the united Sheet Metal body may not be a valid Sheet Metal body.
- The tool body must not contain unfolded bends.
- If you unite bodies that consist of Sheet Metal and Advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.

Three Bend Corner

- The Blend Miter option may not work for Three Bend Corner features created across bends where the central bend does not touch one of the side bends. In other cases some extra edges around the cutout may be incorrectly blended.
- Any gussets on any of the input bends will be lost when you create the Three Bend Corner feature.

Pattern Face in Sheet Metal

The Pattern Face command is a Modeling command that is included in the Sheet Metal application for the convenience of users. It should be used for performance reasons in typical patterning operations where the required result is a large number of pattern objects. For example, patterning a large number of holes, cutouts, dimples, or louvers, on a tab face.

However it is not recommended that it be used in all cases as a substitute for the regular patterning commands in Sheet Metal, because it can cause downstream problems with various sheet metal features such as unbend, rebend, flat solid, copy, paste, and mirror. In these cases, while it may work, it can produce different downstream behavior. For example, a series of flanges that are patterned using the Pattern Face command will unbend and rebend together.

Bend Taper

You cannot use the Bend Taper command to create tapers on bends of advanced flanges and joggles.
Chapter 4: CAM

NX 10 Manufacturing Product Notes

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.

Important release information

NX 9.0.1 and 9.0.2 CAM functionality is included in NX 10.0. However, new CAM functionality introduced in NX 9.0.3 MP1 and MP2 will be included only in NX 10.0.1.

Siemens PLM Software recommends that you wait for the release of NX 10.0.1 for more complete CAM updates.

New functionality in NX 9.0.3 MP1 and MP2 consists of:

- New operation types
- New operation parameters
- IPW tolerances stored in the part file
- New axis properties for machine tools
- New customer default
- New parameter for optimizing a hole sequence

**Warning**

If you open a part file in NX 10.0 and save it, you will not be able to open it again in NX 9.0.3 MP1 or MP2 to access the new functionality.

Maximizing the benefits of multi-core hardware with NX CAM

NX CAM introduced the ability to parallel generate tool paths using multiple cores in NX 7.5. This parallel-processing capability works well for offline programming where multiple operations can be queued up to the available CPU cores on the computer, while the CAM programmer continues to create the rest of the operations or verifies and post processes calculated programs.

Starting with NX 9.0, NX CAM users who also use a 3D IPW to simulate material removal from the operations, benefit from the Parallel Create 3D IPW functionality, which allows them to create the 3D IPW for the operations as a background process that uses parallel processing with multiple cores.

There is good news for NX CAM users who may not work in the offline mode or who are used to the workflow of creating one operation at a time, but still desire the performance benefits of multiple cores during sequential programming tasks. The architectural groundwork has now been laid for NX
CAM to begin the transition to support multi-threaded NX CAM processors. Starting with NX 9.0.3 MP1, NX CAM has begun to utilize multi-threading in a limited way within the tool path generation and verification processors. NX CAM users will see some measurable performance benefits for tool path generation with certain cut patterns and options in Flowcut and Cavity Milling. Greater system-wide support for the remaining NX CAM processors is planned for the upcoming releases.

For more details on the specific options with performance improvements for NX 9.0.3 MP1, contact GTAC.
CAM Early Adopter program

Some of the new NX CAM features are available only upon request through the CAM Early Adopter Program. In order to learn more about these pre-release features, please contact GTAC. GTAC will forward your request to the appropriate development contact.
Tool path and template changes

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

Merging customized templates

You can merge your customized templates with the templates included in this release in the following ways:

- Start with the new default templates and apply your customizations. This is highly recommended to ensure you receive all the PR fixes.
- Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.

Template parts updated for NX 10.0

NX 10.0 template parts include the updates that were initially released for NX 9.0.1 and NX 9.0.2.

Template parts updated for NX 9.0.1

The following template parts were updated in NX 9.0.1.

- hole_making
- mill_contour
- mill_multi_blade
- turning
- Turning_Exp
- MillTurn_Exp
- DieMold_Exp
- library_dialogs (for tool retrieval)
Template part changes for NX 9.0.1

| Operations |
|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|
| • Hole milling and boss milling are now separate operations. In hole_making and mill_planar, the hole_milling and thread_milling operations now machine only holes. |
| • In hole_making, the boss_milling and boss_thread_milling operations have been added to machine bosses. |
| • In hole_making, the clearance settings and inheritance have been corrected for the spot_drilling, drilling, countersinking, and tapping manual drilling operations. |
| • In hole_making, the cleanup pass has been turned on in the hole_milling operation. |
| • In mill_contour and Diemold_Exp, smooth non cutting moves have been turned on in flowcut_single, flowcut_multiple, and flowcut_ref_tool operations. |
| • In turning, Turning_Exp, and MillTurn_Exp, Layout/Layer has been added to the thread_ID operation. |

| Tools |
|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|
| • In turning, and Turning_Exp, the work plane has been corrected and removed from carriers (turrets). This fixes the tool mapping errors reported in PR 6949464. |
| The workaround and downloadable fix described in SFB-NX-7699 (NX 9 Tool mapping fails with NX 9 Turning Carrier) are no longer needed. |

| Methods |
|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|
| • In turning, Turning_Exp, and MillTurn_Exp, non-rapid feeds have been set to 100% Cut. |

Template parts updated for NX 9.0.2

The hole_making template part was updated in NX 9.0.2.

Template part changes for NX 9.0.2

| Operations |
|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|-----------------|
| • In hole_making, there is a new hole_chamfer_milling operation. |
| • In hole_making, the Tapping operation now has the Gouge Checking option activated. |

Template updates in maintenance releases (MR)

Previous maintenance releases did not require changes to the provided templates, and the templates were not updated in these releases. Current maintenance releases contain significant enhancements that often require updates to the provided templates. When there are updated templates in a maintenance release, NX places them in an update folder in the MACH folder structure. The new Use Latest Updated Templates customer default controls where NX looks for templates, and is on by default.
When the **Use Latest Updated Templates** customer default is selected, native NX looks for templates in the *update* folder first (1). If the *update* folder does not contain the required template, NX then looks in the folder where the main release templates are stored. The main release templates are stored in the location specified by the `cam_resource_dir` environment variable, and by default, this location is `MACH/resource/template_part` (2).

![MACH]
- resource
  - template_part Location for main release template files
- updates
  - template_part Location for maintenance release template files

If you do not customize your templates, you do not need to do anything differently. Native NX will automatically use the correct templates.

If you use customized templates in native NX:

1. Save them in a different location from the templates provided with the main release.

2. Modify the `cam_resource_dir` environment variable to point to their location.

3. Turn off the **Use Latest Updated Templates** customer default so that NX looks for your templates in the correct location.

   **Tip**

   To find a customer default, choose **File** tab→**Utilities**→**Customer Defaults**, and click **Find Default**.

If you use Teamcenter Integration for NX, the Teamcenter administrator must do the following to import the maintenance release templates:

1. Copy the templates from the `updates\template_part` folder to the `resource\template_part` folder.

2. Run the `tcin_cam_template_setup.bat` script.
Manufacturing critical maintenance and retirement notices

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens NX 10.0→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance, but will not be removed or hidden from the system for the next two to three releases.

The following operations and geometry objects in the current Drill template are affected:

- DRILL_GEOM
- SPOT_FACING
- SPOT_DRILLING
- DRILLING
- PECK_DRILLING
- BREAKCHIP_DRILLING
- BORING
- REAMING
- COUNTERBORING
- COUNTERSINKING
- TAPPING

A new manual holemaking module has been introduced for NX 9 and should be used instead of the Point To Point module. The new method to manually drill holes will fully replace the Point To Point module over the course of the next two to three releases.

The migration of Point To Point operations is not committed at this time, but will be considered for a future release.

Legacy Lathe retirement from all platforms

Legacy Lathe is now unsupported, and will be removed in a future release.

Legacy Lathe includes the following operations, which are not available in the default Turning templates today.
• LATHE-DRILL
• LATHE-ROUGH
• LATHE-FINISH
• DRIVE-CURVE-LATHE
• LATHE-GROOVE
• LATHE-THREAD

Turning offers equivalent functionality.
• Centerline drilling operations
• Roughing operations
• Finishing operations
• Manually defined operations (TEACH_MODE)
• Roughing operations with a plunge cutting strategy to cut grooves
• Threading operations

**GPM Postprocessor retirement from all platforms**

GPM Postprocessing has been removed completely from NX.

GPM Postprocessing was replaced with NX Post and Post Builder and placed on critical maintenance in 2003. No issues have been corrected since 2003, and no functionality has been added. Although support for GPM Postprocessing was only scheduled through NX 2, GPM Postprocessing continued to remain on critical maintenance until 7.5.

GPM Postprocessing included the following executable items.

• GPM
• MDFG
• CLS2CLF
• ACSMDF
• XLATOR

All users should have completed migration from the GPM Postprocessor to NX Post before NX 8. You can obtain current postprocessors in the following ways:

• Create the postprocessor with Post Builder.
• Download a postprocessor from the Web site and edit it.

In the Manufacturing application, choose Help→Online Technical Support→Download NC Postprocessor
• Contact your account representative or reseller to purchase or customize a postprocessor.
General changes

IPW

A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a Machine Control subop with a Set Modes event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.

If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the Generic Motion operation. For example, if the Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

Note

This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

2D Dynamic collision display when verifying a tool path

In previous releases, rapid tool motions through the Part, Blank or IPW were displayed in the red gouge color as material removed. In the current release, the material removal from these tool motions is not displayed, so you will not see these collisions. To check for collisions, do one of the following:

• Click List after the simulation stops.

• Click Collision Settings. In the Collision Settings dialog box, select the Pause on Collision check box to stop the visualization when a collision occurs. This option does not work if you step through the operation.

Collision check, gouge check and allowed violations of part geometry — NX 9.0.2, NX 9.0.3

The Collision Check for Cutting option checks for possible collisions during the drilling cycle. NX checks the tool holder and all non-cutting portions of the tool against the part and check geometry. If a collision occurs, NX reports the collision and does not generate a tool path.

The Gouge Checking option checks for possible gouges during the drilling cycle. NX checks only the cutting portion of the tool to determine if it violates the finished part geometry outside the purple In-process feature volumes. If a gouge occurs, NX may report the gouge, but still generates the tool path. This is because NX does not know if the gouge is intentional (authorized) or unintentional (unauthorized).

User Defined Operation and API Enhancements

The User Defined Operation API now has the ability to:

• Use the 3D milling IPW from a previous operation as the blank.

• Write level markers to the tool path. In verify, a tool path will have the ability to display one level at a time, just like a Cavity Milling operation.
Machine Tool changes

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.
Integrated Simulation and Verification (ISV)

CSE Parser

The CSE parser was changed for NX 8.5. The CCF files supplied with the installed machines in earlier releases can cause error warnings if they are used in NX 8.5 or later versions.

- If you use one of the standard installed machines supplied with NX, retrieve the newest version of the machine into your Manufacturing setup file.

- If you use a machine tool that is based on one of the standard installed machines supplied with NX, replace the CCF files with the current versions.

- If you use a machine tool with a customized MCF file, it can be used in NX 10 without any changes if the MCF does not include syntax errors. Syntax errors may not have been reported prior to NX 8.

ISV Simulation

- If the spindle speed is zero for an operation, then no material is removed from the IPW.

- Internal and external simulations now use the same geometry definitions for the part and the workpiece. You must assign the geometry to the related kinematic model components, which are classified as _PART and _WORKPIECE.

  If a legacy part does not have geometry defined in the kinematics model, NX uses the geometry defined in the Operation Navigator for internal simulations.

- The Part/Tool collision pair does not support clearances.

- The Part/Tool collision pair is ignored for tool types other than Drilling and Milling.

- Clearance violations are not supported for a collision check between the active tool and the IPW.

- CSE-based simulation and tool path simulation distinguish between the spinning and the non-spinning geometry of the tool and objects on spindles. MTD-based simulation does not support this distinction.

- Tool path based simulation does not support probing cycles. If possible, use NC file-based simulation.

  Menu→Tools→Simulate Machine Code File

IPW

- IPW processing is supported for solid bodies as input blank geometry only.

- The Show Thickness by Color option used in ISV and Visualize is supported for Milling IPW only. Turning is not supported.

Gouge checking

The following are not supported when you right-click operations in the Operation Navigator and choose Tool Path→Gouge Check.
• Non uniform stock

If non uniform stock is detected, only one of the stock values is considered. NX displays this value in the **Gouge and Collision Check** dialog box, in the **Gouge Check Stock** box, and writes the value to the output window. You can use this value or select the **User Defined** option and enter a value.

• Turning

**Blank definition**

Blank defined as an offset distance from the part is not supported if the part is a mixture of solids and sheets.

**Verify**

Concave tools are not supported in **2D Dynamic** verify. Concave tools are supported in **3D Dynamic** verify.
Feature-based Machining (FBM)

Feature-based Machining PMI

The environment variable UGII_CAM_FBM_PMI_FROM_WAVE is no longer supported. To copy threads for wave linked models in your FBM process, you must do the following:

In the WAVE Geometry Linker dialog box, in the Settings group, select the Copy Threads check box.

If you do not select this check box:

- When you use the Find Features command, NX does not find threaded machining features.
- When you update an FBM process created in previous NX versions using the UGII_CAM_FBM_PMI_FROM_WAVE environment variable, NX deletes any existing threaded machining features.

Manufacturing caveats

General caveats

Tool Path Editor

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you trim a tool path, specifying a lowest safe z transfer method results in a direct move between the transfer points instead of a Z-move and then a direct move.</td>
<td>None. This will be corrected for the final release.</td>
</tr>
</tbody>
</table>

Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions where they are not needed, and the moves can cause gouges.</td>
<td>None</td>
</tr>
</tbody>
</table>
Milling caveats

Curve/Point drive method — Offset Left option

As a temporary limitation, NX does not trim the loops in the offset tool path, and the tool path does not roll around sharp edges.

Rotary Floor milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Min. Lead Angle does not influence the tool path.</td>
<td>None</td>
</tr>
<tr>
<td>When you use sheet geometry to define a concave floor, sometimes the default material side is wrong and no tool path is produced.</td>
<td>1. In the Rotary Floor Finish Drive Method dialog box, in the Drive Geometry group, click Flip Material. 2. Generate the operation.</td>
</tr>
<tr>
<td>The cutting parameters option Roll Tool Over Edges does not affect the tool path.</td>
<td>None. This parameter will be removed.</td>
</tr>
</tbody>
</table>

Non Cutting Moves

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z-Level operations with cutter compensation set may have the wrong engage or retract motions when the open area engage type, or the retract type, is also set to one of the following options:</td>
<td>Examine the generated engage and retract moves. If they are not acceptable, consider using a different open engage type or retract type.</td>
</tr>
<tr>
<td>• Arc – Parallel to Tool Axis</td>
<td></td>
</tr>
<tr>
<td>• Arc – Normal to Tool Axis</td>
<td></td>
</tr>
<tr>
<td>• Arc – Normal to Part</td>
<td></td>
</tr>
</tbody>
</table>

Cavity Milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is significant slowdown when the new Cut Below Overhanging Blank option is turned off.</td>
<td>None. The processor must do more calculations to detect and avoid the unproductive cuts. In applicable cases, there is a significant saving in machining time, and the extra generation time is well spent. If the part does not have areas with overhanging blank, do not clear the check box.</td>
</tr>
<tr>
<td>Cut Below Overhanging Blank</td>
<td></td>
</tr>
</tbody>
</table>

Fixed-axis contouring cut area selection

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Area Milling cut regions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you edit a cut area created with the selection method set to <strong>Edge Bounded Region</strong>, the seed face and the bounding edges display in the selection color and are difficult to identify.</td>
<td>You can use the alternate selection color to identify the seed face and bounding edges.</td>
</tr>
<tr>
<td>• To see the seed face, click <strong>Select Bounding Edges</strong>.</td>
<td>• To see the seed face, click <strong>Select Bounding Edges</strong>.</td>
</tr>
<tr>
<td>• To see the bounding edges, click <strong>Select Seed Face</strong>.</td>
<td>• To see the bounding edges, click <strong>Select Seed Face</strong>.</td>
</tr>
<tr>
<td><strong>Tip</strong> If you still cannot see the bounding edges, increase the line width display.</td>
<td>If you still cannot see the bounding edges, increase the line width display.</td>
</tr>
</tbody>
</table>

### Floor Wall Milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut regions can collapse for the following cut patterns if the <strong>Tool Overhang</strong> value is less than 100%:</td>
<td></td>
</tr>
<tr>
<td>• Follow Part</td>
<td>Change the <strong>Tool Overhang</strong> value.</td>
</tr>
<tr>
<td>• Follow Periphery</td>
<td>Change the <strong>Tool Overhang</strong> value.</td>
</tr>
<tr>
<td>• Trochoidal</td>
<td>Change the <strong>Tool Overhang</strong> value.</td>
</tr>
</tbody>
</table>

**Floor Wall Milling** menu→**Preferences**→**Visualization**→**Visualization Preferences** dialog box→**Line** tab→**Part Settings** group→**Show Widths** checkbox→set **Width Scale** to **Maximum**.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>NX does not consider the part geometry between features when merging the tool path. This can result in the following:</td>
<td>• Reducing the <strong>Merge Distance</strong> value may help.</td>
</tr>
<tr>
<td>• Cut levels where features that should not have merged interfere with each other.</td>
<td><strong>Floor Wall Milling</strong> dialog box→<strong>Path Settings</strong> group→<strong>Cutting Parameters</strong> dialog box→<strong>Containment</strong> tab→<strong>Cut Regions</strong> group.</td>
</tr>
<tr>
<td>• Wrong sequencing.</td>
<td>• Alternatively, create separate operations for each feature.</td>
</tr>
<tr>
<td>When features are merged, the merged shapes are sometimes larger than they should be. As a result, the cut areas and completed tool path are also larger than they should be.</td>
<td></td>
</tr>
<tr>
<td>NX does not always merge cut areas when the <strong>Blank</strong> option is set to <strong>Blank Geometry</strong> or <strong>3D IPW</strong>.</td>
<td>None</td>
</tr>
<tr>
<td>NX should ignore gaps smaller than the <strong>Merge Distance</strong> value to create a continuous tool path.</td>
<td>Create separate operations for each feature.</td>
</tr>
<tr>
<td>The <strong>Part Outline</strong> and <strong>Blank Outline</strong> options for <strong>Extend Floor To</strong> always creates a single feature, even if the final cut areas are not continuous. This can result in the following:</td>
<td></td>
</tr>
<tr>
<td>• Cut levels where features that should not have merged interfere with each other. (Similar to the <strong>Merge</strong> issue.)</td>
<td></td>
</tr>
<tr>
<td>• No sequencing.</td>
<td>None</td>
</tr>
<tr>
<td>Region sequencing is only done between features. It is not done between regions within features. This can result in an overall sequence that is not optimal. This is especially noticeable in operations with a single feature, such as when you extend the tool path to the part or blank outline.</td>
<td>Use the following options for the best results:</td>
</tr>
<tr>
<td>In some cases, wall extensions can trim off too much or too little.</td>
<td>• <strong>Cut Region Containment</strong> = <strong>Floor</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Exact Positioning</strong> = off</td>
</tr>
<tr>
<td></td>
<td>Use the following options only when needed:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cut Region Containment</strong> = <strong>Wall</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Exact Positioning</strong> = on</td>
</tr>
</tbody>
</table>
### Problem

If the IPW material is wider between two cut levels than it is at the respective cut levels, Floor Wall Milling does not always identify the excess IPW material. As a result, the operation may not cut all the material.

#### Workaround

Use more cut levels.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the IPW material is wider between two cut levels than it is at the respective cut levels, Floor Wall Milling does not always identify the excess IPW material. As a result, the operation may not cut all the material.</td>
<td>Use more cut levels.</td>
</tr>
</tbody>
</table>

The **Exact Positioning** option does not consider the precise tool shape when analyzing blank/IPW geometry. This can make Floor/Wall Milling identify too much IPW material, which can result in air cutting.

#### Workaround

None

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Exact Positioning</strong> option does not consider the precise tool shape when analyzing blank/IPW geometry. This can make Floor/Wall Milling identify too much IPW material, which can result in air cutting.</td>
<td>None</td>
</tr>
</tbody>
</table>

### Flow Cut

#### Problem

Bull nose reference tool performance may be slow.

When the reference tool radius is approximately the same size as the fillets on the part, as in near-fit conditions, inconsistent and/or extra tool path may be produced.

Using the **Minimum Cut Length** option can remove small cut-motions in steep corners, especially when the remaining uncut material is narrow.

#### Workaround

None

Increase the overlap distance and/or tighten the operation tolerances to help reduce occurrences.

In the **Flow Cut Drive Method** dialog box, reduce **Minimum Cut Length** to a small value or 0.0 to ensure that cut-motions are not removed.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bull nose reference tool performance may be slow.</td>
<td>None</td>
</tr>
<tr>
<td>When the reference tool radius is approximately the same size as the fillets on the part, as in near-fit conditions, inconsistent and/or extra tool path may be produced.</td>
<td>Increase the overlap distance and/or tighten the operation tolerances to help reduce occurrences.</td>
</tr>
<tr>
<td>Using the <strong>Minimum Cut Length</strong> option can remove small cut-motions in steep corners, especially when the remaining uncut material is narrow.</td>
<td>In the <strong>Flow Cut Drive Method</strong> dialog box, reduce <strong>Minimum Cut Length</strong> to a small value or 0.0 to ensure that cut-motions are not removed.</td>
</tr>
</tbody>
</table>
Contour Profile variable axis profiling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contour Profile operations only compensate for diminishing walls when the wall is in contact with the floor.</td>
<td>None</td>
</tr>
</tbody>
</table>

- **Supported cases:**
  - ![Supported case 1](image1.png)
  - ![Supported case 2](image2.png)

- **Not supported cases:**
  - ![Not supported case 1](image3.png)
  - ![Not supported case 2](image4.png)

Multiple offset passes that push the tool entirely above the wall height significantly increase generation time. To reduce generation time, limit the number of offsets so that they do not exceed the wall height.
ISV caveats

Visualize 2D Dynamic

• If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.

• On the Linux and Mac OS X platforms, the 2D Dynamic tab may not be active.
  The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example:
  NVidia Quadro and FX graphics drivers
  In the XF86Config file, in the Device section, set CIOverlay to TRUE.

Simulation

• In certain cases the reported minimum distance of a clearance violation is not the closest distance.

• Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases.

• Collision checking between the IPW and active non-spinning tools is performed with the spinning geometry of the cutting and non-cutting parts of the tool, which can lead to false reports of collisions. In the following graphic, the green outline indicates the geometry that is actually used for collision checking.

• For a collision between the IPW and the cutting segment of a non-spinning active tool, the following false error message is displayed:
  Tool and IPW are colliding in Rapid Mode

• The gouge checker may report error messages even if the collision check is turned off. For example, if no solid exists and you use the following settings:
Simulation Settings dialog box → Collision Detection group

Collision Detection = Off

Tool Shape = Solid Assembly

- If you use a solid tool with the following setting, NX may warn you that the tool does not have a solid.

Simulation Settings dialog box → Collision Detection group

Tool Shape = Solid Assembly

Mill-turn part and blank visibility

When you simulate a mill-turn operation, the part and blank may become visible even if you selected the **Hide Part Geometry** and **Hide Blank Geometry** check boxes in the **Simulation Settings** dialog box. This may happen after you clear the **Show 3D Material Removal** check box in the **Simulation Control Panel** dialog box during the simulation.

Positional ISV — Show Machine Axis Positions dialog box

When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the **Show Machine Axis Positions** dialog box. To avoid confusion, use the **Show Machine Axis Positions** customer default to suppress the dialog box.

1. Choose **File** tab → **Utilities** → **Customer Defaults**.

2. In the **Customer Defaults** dialog box, choose **Manufacturing** → **User Interface**.

3. Click the **Dialog Boxes** tab, and in the **Visibility** group, clear the **Show Machine Axis Positions Dialog** check box.
Turning caveats

In Turning, you cannot select an in-process workpiece from an external source to define the blank.
Manual drilling, Hole Milling, Thread Milling

Manual Drilling

- There are wrong alerts after selecting geometry or generating a tool path.

Optimizing a hole sequence

If you use the Primary Direction option to optimize a hole sequence at the Hole or boss Geometry level, you may see the following error message:

A deleted or invalid class id was used.

As a workaround, restart your NX session.

Manufacturing documentation corrections

Documentation correction — Tracking points for drilling tools

CAM→Hole Machining→Hole machining tools→Tracking points for drilling tools
CAM→What’s new in NX 10→CAM NX 9.0.1 — NX 10.0→Hole machining→Tracking points for drilling tools

The Tracking points for drilling tools topic incorrectly shows tracking points at the bottom of each step in a step drill.

The additional system-defined tracking points for each step are located at the top of the step.

Correct

Incorrect

Multi Blade corrections

Swarf Blade tool axis (Multi Blade)

Use the Swarf Blade tool axis option to align the tool axis to the blade profile. You can use this option as a base for any Multi Blade operation. The tool axis orientation is not sensitive to UV alignment, and the blade surface can contain multiple UV patches.
For swarf cutting or flank milling, to finish cut blades using the side of the tool, you typically set the **Number of Cuts** option to 1. If the flute of your tool is not long enough to swarf cut the entire blade in a single pass, NX uses the same orientation for all of the cut levels.

![Diagram](image)

**Axis = Swarf Blade, Cut Levels = 1, Number of Cuts = 1**

For **Blade Finish** operations on blades or splitters, the behavior of the **Swarf Blade** tool axis option depends on whether you use collision checking.

When you clear the **Collision Check** check box, NX does the following:

- Better aligns the tool axis with blades that are appropriate for swarf cuts.

![Collision Check](image)

- Supports bull nose and flat end mills in addition to ball mills.

- Uses the specified **Tilt Clearance Angle** value to define a lead angle for the tool as it begins and ends the cutting pass. Only positive values are allowed.
When you select the **Collision Check** check box, NX does the following:

- Tilts the tool away from the blade to avoid gouges, and trims sections of the tool path with collisions.

- Uses the specified **Tilt Clearance Angle** value to define the minimal allowed deviation between the tool and the blade, blend, splitter, and check geometry.
**Note**

When you use the **Swarf Blade** tool axis option, we recommend the following:

- Clear the **Collision Check** check box when you machine blades with ruled surfaces that allow a perfect match.

- Select the **Collision Check** check box when you machine blades with double curvature. If you clear the check box, there is a significant risk of overcuts or gouging.

---

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisite</td>
<td>Requires the <em>NX Turbo Machinery Add-on</em> license.</td>
</tr>
<tr>
<td>Location in dialog box</td>
<td>[Multi blade operation] dialog box→<strong>Tool Axis</strong> group</td>
</tr>
</tbody>
</table>

**Swarf Blade (tool axis) dialog box**

**Tool Axis**

**Tilt Clearance Angle**

When the **Collision Check** check box is selected, **Tilt Clearance Angle** controls the minimal allowed deviation between the tool and the following geometries:

- Blade geometry

- Blend and splitter geometry in the milling region

- Check geometry
When the Collision Check check box is cleared, Tilt Clearance Angle defines a lead angle for the tool as it begins and ends the cutting pass. Only positive values are allowed.

Collision Check
Available for Blade Finish operations on blades or splitters.
Controls how NX applies the Tilt Clearance Angle option.

- **Collision Check**
  - Tilts the tool away from the blade to avoid gouges, and trims sections of the tool path with collisions.
  - Uses the specified Tilt Clearance Angle value to define the minimal allowed deviation between the tool and the blade, blend, splitter, and check geometry.
Collision Check

• Better aligns the tool axis with blades that are appropriate for swarf cuts.

• Supports bull nose and flat end mills in addition to ball mills.

• Uses the specified **Tilt Clearance Angle** value to define a lead angle for the tool as it begins and ends the cutting pass.

The following options are available for **Multi Blade Rough**, **Hub Finish**, and **Blend Finish** operations.

- **Lead Angle at Leading Edge**
- **Lead Angle at Trailing Edge**
- **Minimum Lead Angle**

Let you control the lead angle as the tool moves from edge to edge.

Can prevent heal digging when the cutting direction and tool angle changes.

---

**Align the side of the tool to the blade**

This example shows how to finish cut a blade with ruled surfaces using the **Swarf Blade** option.

1. Choose **Home tab→Insert group→Create Operation**

2. Set the options as shown and click **OK**.

   - **Type** = `mill_multi_blade`
   - **Operation Subtype** = `Blade Finish`
   - **Geometry** = `MULTI_BLADE_GEOM`

3. In the **Blade Finish** dialog box, in the **Tool Axis** group, from the **Axis** list, select **Swarf Blade**.

4. In the **Swarf Blade** dialog box, set the options as shown and click **OK**.

   - **Tool Axis** group
     - **Tilt Clearance Angle** = 0
Collision Check = ☐

With these settings, the tool alignment best matches ruled surfaces, and the lead angle is 0 degrees when the tool begins cutting.

5. In the Blade Finish dialog box, in the Path Settings group, click Cut Levels.

6. In the Cut Levels dialog box, set the options as shown:
   - Depth Options group
     - Range Depth = Specify
     - Number of Cuts = 1

7. Click OK to save the settings and return to the operation dialog box.

8. In the Blade Finish dialog box, in the Actions group, click Generate.

9. Evaluate the tool path.
   a. Click Verify.
   b. In the Tool Path Visualization dialog box, click the Replay tab.
   c. Turn on gouge check.

   When you clear the Collision Check check box in the Swarf Blade dialog box, there is a risk of gouging. In some cases, slight gouges are acceptable as long as the tool path is continuous and smooth. We recommend that you turn on the gouge check when verifying the operation and evaluate the result.

   A. Click Gouge and Collision Settings.

   B. In the Gouge and Collision Settings dialog box, set the options as shown:
      - Gouge Checking group
        - Check for Gouges = ☑
      - Collision Checking group
        - Check Tool and Holder = ☑
      - Gouge and Collision Settings group
        - Display Gouges = ☑
        - Refresh between Gouges = ☐
        - List Gouges when Finished = ☐
d. Click **Play**. The tool approach is parallel to the leading edge of the blade.

![Tool Approach Diagram]

The tool optimally swarf cuts the blade at each point in the tool path.

![Tool Optimally Swarf Cutting Diagram]

10. Click **OK** to close the dialog box.

11. Change the **Tilt Clearance Angle** to 20, and then generate and verify the operation. The tool approach is now at a 20° angle to the leading edge of the blade.
12. In the **Blade Finish** dialog box, in the **Actions** group, click **OK** to save the operation.
Chapter 5: CAE

Advanced Simulation

Caveats

Boundary layer meshing

The Auto Fix Failed Elements option in the 3D Tetrahedral Mesh dialog box does not work for tetrahedral meshes created with the Boundary Layer type in the Mesh Control dialog box.

Load Recipe Manager

• Currently, the Load Recipes Manager is capable of handling up to 10,000 functions. In future releases, the Load Recipes Manager will be enhanced to handle more functions.

• Vector format data is not yet supported in the Load Recipes Manager.

• If you create a solution using the New Solution from Load Recipe command and manually delete all the solution steps, the Update Solution from Load Recipe will not work. In this case, you have to create a new solution from the load recipe. This issue will be addressed in NX 11.

Post Processing

• For NX Nastran laminate composite results, NX Post-processing takes the in-plane and inter-laminar stresses together to calculate the ply-stress invariants. Consequently, the values reported by NX Post-processing are different from the values found reported in the NX Nastran results file (.f06).

• The material orientation vector display is incorrect for the following types of NX Nastran and MSC Nastran elements:
  o  CQUAD4
  o  CQUAD8
  o  CTRAX3
  o  CTRAX6

• You cannot use the Result Probe command to display results on models that contain super elements.
JT results support

This release includes enhancements to JT file creation from NX Post Processing. JT files that you create in NX 10 are compatible with the JT V10 format, and you can view the file in Teamcenter Visualization. Currently, there are known issues with JT files in NX 10 in Teamcenter Visualization.

Teamcenter Visualization does not always recognize the CAE content in a JT file. To work around this issue, check and set the OpenGL version as follows:

1. Load a JT file in Teamcenter Visualization.
2. Right-click the JT file and select Performance→Edit→Troubleshoot.
3. Set the OpenGL version to version 3.2 or higher.
4. Shut down Teamcenter Visualization.
5. Restart Teamcenter Visualization.

Materials

In NX 7.5, the default material library changed from an NX-specific .dat format to a MatML XML format. Starting with NX 11, the legacy material library .dat format will no longer be supported.

NX Nastran environment

When you create a Frequency Excitation load set with the Type set to Enforced Velocity, NX exports the load set incorrectly when the Velocity Time Unit list is set to hr and when the Definition option is set to either Expression – Real/Imaginary or Expression – Magnitude/Phase. To avoid this issue, select the Field option from the Definition list to define the excitation as field.

Abaqus environment

Issues occur when you import an Abaqus input file that has multiple surface pairs defined with the same *CONTACT PAIR keyword. Currently, if all surfaces that comprise the master surfaces or the slave surfaces do not have the same entity type, NX fails to import the input file. For example, you cannot import a master surface in which some surfaces are defined with nodes and some are defined with elements. Likewise, you cannot import a slave surface if some of the surfaces are defined with element faces or edges and others are defined with nodes. However, NX can import models in which the master and slave surfaces are comprised of surfaces that are defined with different entity types. For example, you can define all the surfaces that comprise the master surfaces with nodes and define all the surfaces that comprise the slave surfaces with elements.

ANSYS environment

- When you export or solve a solution with a Transient Dynamic type of step, NX only writes out the first Transient Initial Conditions constraint in the solution to your ANSYS input file. Any other Transient Initial Conditions constraints are not written out. To work around this issue, combine all Transient Initial Conditions constraints into a single constraint.

Note

The Transient Initial Conditions constraint corresponds to the ANSYS IC command.
In the Region dialog box, if you select Yes from the Use ESURF list, you must also select Flexible from the Type list in the new Region Type and Pilot Node group of options. Rigid body type regions are only supported in ANSYS when you select No from the Use ESURF list. Currently, if you select No from the Use ESURF list and then select Yes, the Select Master Grid Point option is visible. This option should only be visible when you select No from the Use ESURF list. However, NX correctly writes out the ANSYS input file without the pilot node.

**LS-DYNA environment**

- You cannot define the material orientation for *ELEMENT_TSHELL elements. This issue is addressed in the NX 10.01 release.
- Material *MAT_116 (*MAT_COMPOSITE_LAYUP) is not supported for import.
- Material *MAT_054-055 (*MAT_ENHANCED_COMPOSITE_DAMAGE) is now supported for import and export. However, during import, NX incorrectly maps *MAT_054-055 in the user interface to *MAT_COMPOSITE_LAYUP (the default).
- You can now define the stress-strain curve for LS-DYNA materials. NX exports this data as the LS-DYNA keyword *MAT_PIECEWISE_LINEAR_PLASTICITY or as *MAT_024. However, the NX Material library does not provide the correct plastic strain value for the LS-DYNA solver at the starting point of the curve. In LS-DYNA, the curve must start at a non-zero value. To work around this issue, you must manually correct the starting point value. Additionally:
  - Temperature-dependent stress-strain data is currently unsupported. Although you can define it in NX, only the first temperature value is exported to your LS-DYNA input file.
  - The *MAT_PIECEWISE_LINEAR_PLASTICITY keyword is not yet supported for import. It will be supported either after the NX 10 Beta or in a future release.

**Samcef environment**

- Currently, you cannot compute the inertial properties of a mesh.
- Scale factors on constraints are not taken into account.
- There are issues in the output file when the model’s specified unit of length is inches.
- When you post-process results from a Samcef solution in NX, NX does not support the loading or display of Samcef special beams results (code 1439).
- For the Samcef **Bush** element, the Viscous Damping rotation properties in the **Bush Properties** dialog box have the wrong properties.

**Geometry optimization**

Beginning in NX 10, Altair HyperOpt is no longer available as an optimization type in NX. All geometry optimization is now performed with the **NX Optimizer**. Parts from previous releases with optimization solutions that used Altair HyperOpt are automatically converted to use the **NX Optimizer** instead.

Additionally, the Knowledge Fusion (KF) class ug_hyperopt_optimize has been retired. This class no longer appears in the BOM and is no longer supported. Part conversion of KF objects is not
supported. Therefore, if you have legacy parts that contain instances of `ug_hyperopt_optimize`, you must replace these objects with KF class `ug_optimize` instead.

**NX Multiphysics environment**

The inherited concentrated mass material is not used by the thermal solver.

**NX Thermal and Flow, NX Space Systems Thermal, and NX Electronic Systems Cooling**

- The **Automatic Pairing** type of the **Disjoint Fluid Mesh Pairing** simulation object is not working in NX 10.
  
  Workaround: use the **Manual Pairing** type.

- Beginning in NX 10, the **Radiative Heating** simulation object no longer supports spatial distribution of the power when the **Heat Load Type** list is set to **Total Power**.

- The import of an XML input file containing simulation objects, constraints, or loads defined by a dimensionless spatial distribution, 4D field (heterogeneous or table of fields), or specific symbolic expression (for example a plugin function that takes a named point as an argument) is not supported.

- For two-phase, immiscible fluid simulations, the fractional step scheme is not supported. You must use the fully coupled pressure-velocity scheme.

- Beginning in NX 9, to use the following commands and features, you must have a license of the NX Advanced Fluid Modeling product:
  
  o **Surface Wrap Body** command

  o **Local Resolution Constraint** command

  o **Contact Prevention Constraint** command

  o **Fluid Domain** simulation object

  o CGNS export of your fluid model

- NX 9, NX 9.0.x, and NX 10 cannot use NX 8.5 or older parallel configuration XML files. When you open an old XML file in the Parallel Configuration Tool, only the filename is preserved. You must make all appropriate selections before saving the file to use it for parallel processing.

- The inherited concentrated mass material is not used by the thermal solver.

**Response Simulation**

The software allows you to create an **Enforced Motion** load in a **Static Load Set**. However, Response Simulation does not recognize that enforced motion load when you create an event.

**Durability**

- Non-English characters in material names cause Durability solver errors.

- Durability only uses table fields for S-N and E-N curves.
Laminate Composites

- Round-tripping an H5 file can result in orphan elements, even if the mesh is unchanged.

- The **Analyze Laminate Strength** command incorrectly sets the ΔT value from a temperature load to zero when converting XY strain to XY stress, instead of using the specified value. Therefore, strength results are incorrect when you specify a temperature load.

- If your Samcef layup contains cohesive layers and you attempt to inflate its domain or a subset of its domain more than once, you may get a memory access violation.

  Workaround: Inflate the entire domain at once, or define a separate collector and physical property for each inflation.
Documentation notes

Materials documentation

• In the topic *Adding material properties to existing material definitions* (located at Home→CAE→Advanced Simulation→Materials→Using custom materials), the name of the startup folder in which you should place your custom XML file is misspelled. The name should be `UGII_VENDOR_DIR\startup`.

• When you link to or copy a feature and that action creates a new body, NX copies the attributes of the source body to the target body, including its material assignment. For example, suppose you have a part that has no material assignment. In the Sketching environment, you insert a recipe curve onto a face in the part. When you open the Assign Material dialog box, you will see that the part has inherited the material that was assigned to the recipe curve. This behavior is not described in the materials documentation.

Motion Simulation

Caveats

LMS Motion Solver

The following motion commands are not supported with the LMS Motion Solver:

• **2–3 Joint Coupler** — You can couple two joints, but not three.

• **Joint Friction**

• **Point on Surface**

• **2D Contact**

• **3D Contact**

• **Quick Drag**

• **Graph** — Graphing of Relative Force, Sensor Absolute, and Sensor Relative are not supported.

• **Flexible Link**

• **PMDC Motor**

• **Signal Chart**

• **Plant Input**

• **Plant Output**

• **Co-simulation**

• These solver functions are not supported:
- CHEBY
- CONTACT
- FORCOS
- FORSIN
- FM
- FX
- FY
- FZ
- TM
- TX
- TY
- TZ
Chapter 6: Programming Tools

The Release Notes for Programming Tools are available only with the installed NX Help documentation. After you install the documentation, you can access the information from any of the following locations.

• From the Start menu on your system, choose:
  o All Programs→Siemens NX 10.0→Documentation→NX Release Notes.
  o All Programs→Siemens NX 10.0→Release Information→NX Release Notes.

• Within NX, choose:
  o File tab→Help→Release Notes.
  o Menu→Help→Release Notes.
Chapter 7: Inspection and validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not yet recognize unset part attributes.

CMM Inspection Programming

Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.
Chapter 8: Tooling Design

Weld Assistant

Documentation Notes

Convert Legacy Weld Points utility

You can use the **Convert Legacy Weld Points** weld utility to convert pre-NX 10 weld points to the same style as the weld point features that are created by the **Weld Point Wizard**.

However, you cannot use this utility to convert pre-NX 5 weld points. To convert the pre-NX 5 weld points, you can do the following:

1. Export the locations of the weld points to a CSV file using the **Export CSV** command.

2. Import the same CSV file using the **Import CSV** command.
Electrode Design

Three additional coordinate system (CSYS) definitions are supported in Electrode Design in NX 10. You can define the CSYS’s in the blank templates. Once you add a blank to your electrode assembly, the CSYS’s dimensions will be reflected in the BOM.

The EW_HOLDER_CSYS indicates the end position of the sparking operation. The following attributes for this CSYS are provided in the electrode:

- EW_HOLDER_X
- EW_HOLDER_Y
- EW_HOLDER_Z
- EW_HOLDER_ANG

The EW_HOLDER_ROUTE_CSYS indicates the start position of the sparking operation. Generally, this is the installation position of the electrode on the EDM machine. The following attributes for this CSYS are provided in the electrode:

- EW_HOLDER_ROUTE_X
- EW_HOLDER_ROUTE_Y
- EW_HOLDER_ROUTE_Z
- EW_HOLDER_ROUTE_ANG

For some special undercut sparking cases, and under conditions where there are special clearance issues, the electrode will move down to a position first before starting the sparking operation. The
EW_HOLDER_ROUTE1_CSYS can be defined as a secondary installation position of the electrode on the EDM machine. The following attributes for this CSYS are provided in the electrode:

- EW_HOLDER_ROUTE1_X
- EW_HOLDER_ROUTE1_Y
- EW_HOLDER_ROUTE1_Z
- EW_HOLDER_ROUTE1_ANG

All the attributes for these additional CSYS’s are created on the instance of the electrode.

If EW_HOLDER_CSYS and EW_HOLDER_ROUTE_CSYS are defined in the electrode part, the sparking projection area will be calculated along the direction from EW_HOLDER_ROUTE_CSYS to EW_HOLDER_CSYS.

ELEC_TOUCH_AREA is created on the electrode to record the actual touch area.

You can create an expression MSET_HIGHPOINT in the MSET part.

If you want to use this value in the blank, you must change the part and data file for the blank:

1. Add a new expression MSET_HIGHPOINT in the part file.
2. Add a new expression MSET_HIGHPOINT=<EW_MSET>::MSET_HIGHPOINT string in the spreadsheet for the electrode blank.
Mold flow analysis

The mold flow analysis tools, Easy Fill, and Easy Fill advanced are available for download on the GTAC ftp site: https://download.industrysoftware.automation.siemens.com/unigraphics/moldwizard/. After you log on to the ftp site, at the moldwizard page, select the nx10 folder, and download the following files:

- EasyFillAdvancednx10.0_data_V1.README.TXT
- EasyFillAdvancednx10.0_data_V1.zip

The README.TXT file supplies information on how and where to install the Easy Fill product.

If you have a Mold Wizard or Molded Part Validation license, you can access the following basic functions:

- Select one gate location
- Obtain analysis results for **Melt Front Time**

To access more advanced functions, you need an Easy Fill or Easy Fill Advanced license.
Context sensitive Help for Tooling Design

In the Mold Wizard, Progressive Die Wizard, and Engineering Die Wizard applications, when the Standard Part Management dialog box is open and you press F1, the Help displays an error message. This will be fixed in NX 10.0.1. This topic is available in the following locations:

- Tooling Design→Mold Design→Mold Design help→Standard parts→Standard Part Management dialog box
- Tooling Design→Progressive Die Design→Standard parts→Standard Part Management dialog box
- Tooling Design→Engineering Die Design→Standard parts→Standard Part Management dialog box

NX 10 Tooling Design, Motion Simulation documentation corrections and additions

Run Simulation

Use this command to view a simulation that shows the kinematics of all the automatic and user-identified components in the model.

You can:

- View the die components and sheet metal parts within the model and check for collisions and interference.
- Detect and analyze the collision at each angle of the simulation.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Mold Wizard and Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td>Run Simulation</td>
</tr>
</tbody>
</table>
## Run Simulation dialog box

### Position in Cycle

| Angle | Lets you move directly to any angle of the simulation, or enter a specific angle. Drag the slider or enter an angle value (between 0-360) to go to a specific position in the simulation. The cycle of the simulation is a set of 360 values, one for each angular increment of 0-359 degrees, that determines how far to move along or about the axis at each point of the simulation. |

### Refresh

| Interval | Lets you control the speed of the simulation. Drag the slider or enter a value between 0-10 degrees to set the refresh rate. This controls the speed of the simulation. The refresh rate is the number of degrees between each step of the animation. |

### Controls

| Control buttons | Let you control the simulation. When you click **Play** NX runs the simulation within 0-360 degrees and repeats this until you click **Stop**. |

### Collision

<p>| Check Collision | Checks the collision and displays the collision in a list. Available when <strong>Check Collision</strong> is on. |
| Stop Simulation at Collision | Stops the simulation when the collision list changes. |
| Highlight Collision | Highlights the colliding bodies during the collision. |
| Ignore Touching | Disregards any touching information that occurs in the simulation. |</p>
<table>
<thead>
<tr>
<th>Shortcut commands</th>
<th>Available in the shortcut menu when you right-click a collision in the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyze</strong></td>
<td>Opens the <strong>Analyze Collision</strong> dialog box where you can see more detailed information about the collisions.</td>
</tr>
<tr>
<td><strong>Ignore This collision</strong></td>
<td>Ignores the selected collision including interference.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Applies only to one collision between the two parts. If the parts collide again at a different point in the cycle, NX detects the collision.</td>
</tr>
<tr>
<td><strong>Ignore Between Parts</strong></td>
<td>Ignores the collision for the selected pair of parts. Displays all currently colliding or interfering pair of parts in a list. The list changes as the simulation progresses. New collisions are added at the top and removed when they no longer collide.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>You can right-click an entry in the list and choose <strong>Ignore</strong> to turn off the collision.</td>
</tr>
<tr>
<td><strong>Collision list</strong></td>
<td>You can choose to ignore just the collision in the current range or all collisions between the two parts. You can turn off collisions that you are not interested in, for example, a collision between the sheet metal and a die at the closed position of the press, which is an expected collision.</td>
</tr>
<tr>
<td><strong>Collision Configuration</strong></td>
<td>Opens the <strong>Collision Configuration</strong> dialog box where you can specify more detailed parameters regarding collisions..</td>
</tr>
<tr>
<td><strong>Collision Information</strong></td>
<td>Opens an <strong>Information</strong> window which includes the detailed collision data.</td>
</tr>
<tr>
<td><strong>Reset Ignored Collision</strong></td>
<td>Restores any ignored collisions to their original state. The restored collisions will appear in the simulation.</td>
</tr>
</tbody>
</table>

**Additional Notes:**
- To see the detailed information about the collisions.
- To turn off the collision.
Preprocess Motion

Use the **Preprocess Motion** command to set and load the kinematic model, and mount the sheet metal or plastic parts of the die or the mold on the kinematic model to prepare your motion simulation data.

You can:

- Clone a predefined kinematic model for tooling into your current assembly or to a directory you specify.

- Change the kinematic model.
  
  NX displays a message window asking you to confirm whether you want to remove the current kinematic model and add another one. You need to click **Yes**, and then mount the components again and redefine the cams.

- Generate control data and import it to a kinematic model according to the die settings. You can also change to different control data and re-read the control data.

- Mount components to the kinematic model.
  
  You can also specify different motion types for the mounted components.

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Mold Wizard and Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>Preprocess Motion</strong></td>
</tr>
</tbody>
</table>
## Preprocess Motion dialog box

**Type**

<table>
<thead>
<tr>
<th>Type list</th>
<th>![Add Kinematic Model]</th>
<th>Add Kinematic Model</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Clones a new set of kinematic parts and adds them to the current tooling assembly as a subassembly.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>![Mount Component]</th>
<th>Mount Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lets you identify components as belonging to a specific kinematic category, such as fixed or moving components.</td>
<td></td>
</tr>
</tbody>
</table>

The following options and groups appear based on what you select from the Type list.

### Kinematic Model

Appears when **Type** is set to **Add Kinematic Model**.

<table>
<thead>
<tr>
<th>List</th>
<th>Lets you select a kinematic model template.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>One template is provided as an example. Two templates are provided as examples.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Target Directory</th>
<th>Sets the folder to which the kinematic components are cloned.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Typically, you should place the kinematic model in a location that is included in your search paths, or with the tooling assembly.</td>
</tr>
</tbody>
</table>

### Kinematic Parameters

Appears when **Type** is set to **Add Kinematic Model**.

The following options appear only in Mold Wizard.

<table>
<thead>
<tr>
<th>Two-plate Style</th>
<th>Specifies whether the mold assembly has two or three plates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Three-plate Style</td>
<td>Lets you define the following kinematic parameters for a mold assembly:</td>
</tr>
</tbody>
</table>

#### Machine Stroke (A)

Sets the injection mold open distance.

#### Ejection Distance (D)

Sets the distance over which the plastic model is ejected when the mold opens.

*Example of a two-plate style mold*
The following parameters appear when **Three-plate Style** is selected.

**Pull Runner Distance (B)**
Sets the distance over which runners are pulled.

**Injection Relief Distance (E)**
Sets the distance between the runner plate and the cavity plate.

*Example of a three-plate style mold*
Eject Product

Let's specify when the ejector plate advances to eject the part from the mold.

- **After Mold Fully Opened**: Advances the ejector plate to release the part, only after the mold is fully open.

- **While Mold Opening**: Advances the ejector plate to release the part as
The following options appear only in Progressive Die Wizard:

- Machine Stroke (D)
- Stripper Travel (A)
- Strip Lift Height (C)
- Strip Lift Height (Feeder2)
- Pitch (Feeder)
- Pitch (Feeder2)
- Transfer Start Angle
- Transfer End Angle
- Strokes per Minute

*Example of a progressive die*

**Settings**

Appears when **Type** is set to **Add Kinematic Model**.
**Rename Kinematic Model** options

- **Rename Components**
  Sets a suffix that is added to cloned kinematic part names.

- **Hide CSYS in Kinematic Model**
  Hides the CSYS in the kinematic model.
  When this check box is cleared, the CSYS is displayed at the center of the mold base in the plane where the A-plates and B-plates meet.
  Creates the kinematic model in all bodies.

- **Include Hidden Bodies**
  When this check box is cleared, NX does not include the kinematic model in bodies that are hidden.

- **Import Control Data**
  Sets a control file to import. The default file is `\moldwizard_dir\templates\tooling_validation.xls`.

- **Export Control Data**
  Creates a standard `.csv` (Comma Separated Values) file with the current control data.
  Appears when **Mount Component** is selected in the **Type** group.

- **Re-read Configure Data File**
  Reruns the mounting calculation. Select this check box after you modify the configuration file `tooling_validation.xls`.
  The file path is `$PDIEWIZARD_DIR\configuration\tooling_validation.xls`.

- **Edit Configure Data File**
  Opens the `tooling_validation.xls` file.

**Component Mounting**

Appears when **Type** is set to **Mount Component**.

- **Motion**
  Lets you select one of the motion nodes in the kinematic model.
  For Mold Wizard, you can choose the following:

  - **Move**
    This node of the kinematic model is the motion driver.
    Add plates such as **BP**, **UP**, **CP**, and so on, and other plates and hardware attached to these plates.

  - **Fix**
    This is the fixed node of the kinematic model.
    If you reposition it, everything else moves with it.
    Add fixed parts such as the A-plates.
Ejection
This node of the kinematic model is used to push the product out of the mold.

Add parts such as ejectors, lifters, and the ejector plates.

Injection
This node of the kinematic model moves along the Z-axis.

Stripper
Product
A lifter type used to define motion. This node of the kinematic model first moves along Z-axis and then along the X or Y-axis.

Add product components to this node.

For Progressive Die Wizard, if you are using the Tooling Kinematic Model template, you can choose from the following:

TOP
BOTTOM
LIFTER
STRIPPER
FEEDER

For Progressive Die Wizard, if you are using the Tooling Kinematic Model 2 template, you can also choose:

FEEDER2
LIFTER2
STRIPPER2

Mounted
Specifications the number of components mounted.

Select Object
Lets you select components when you highlight a node in the list. Selected components are added to the node, and included in the simulation.

Note
Components are added to the node only when you click Apply when Type is set to Mount Component.
Appears when you select PRODUCT motion type in Mold Wizard FEEDER/FEEDER2 motion type in Progressive Die Wizard.

Specify Vector

Let's you specify a vector for the product release direction FEEDER/FEEDER2 move direction.
**User Defined Motion**

Use this command to add user defined motion data to your kinematic model.

You can define:

- Linear movement along a specific vector.
- Angular movement about a specific axis.

The motion curve is a set of 360 values, one for each angular increment of 0-359 degrees, that determines how far to move along or about the axis at each point of the simulation. You can use the simple motion curves created by NX, or supply your own values using a comma separated values (CSV) file.

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Mold Wizard and Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td>User Defined Motion</td>
</tr>
</tbody>
</table>
# User Defined Motion dialog box

<table>
<thead>
<tr>
<th>Bodies in Motion</th>
<th>Lets you select the bodies for the motion you are defining.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Bodies</strong></td>
<td><strong>Motion</strong></td>
</tr>
<tr>
<td></td>
<td>Specifies the type of motion that you want to use.</td>
</tr>
<tr>
<td><strong>Linear</strong></td>
<td>A motion that is in a straight line.</td>
</tr>
<tr>
<td><strong>Rotary</strong></td>
<td>A motion that revolves around an axis.</td>
</tr>
<tr>
<td></td>
<td>Specifies the direction of motion for the selected bodies.</td>
</tr>
<tr>
<td><strong>Specify Vector</strong></td>
<td>Appears when the motion is set to <strong>Rotary</strong>.</td>
</tr>
<tr>
<td></td>
<td>Lets you specify a stationary point around which the selected bodies will rotate.</td>
</tr>
<tr>
<td><strong>Specify Point</strong></td>
<td><strong>Motion Curve</strong></td>
</tr>
<tr>
<td></td>
<td>Sets a linear motion.</td>
</tr>
<tr>
<td></td>
<td>You define the motion using the timing options.</td>
</tr>
<tr>
<td></td>
<td>The motion curve is a set of 360 values, one for each angular increment of 0-359 degrees, that determines how far to move along or about the axis at each point of the simulation.</td>
</tr>
<tr>
<td><strong>Linear</strong></td>
<td>Sets a rotary motion.</td>
</tr>
<tr>
<td></td>
<td>You define the motion using the timing options.</td>
</tr>
<tr>
<td></td>
<td>The motion curve is a set of 360 values, one for each angular increment of 0-359 degrees, that determines how much angle to rotate about the axis at each point of the simulation.</td>
</tr>
<tr>
<td><strong>Press Timing</strong></td>
<td><strong>Start</strong></td>
</tr>
<tr>
<td></td>
<td>Lets you specify the start angle.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>Lets you specify the stop angle.</td>
</tr>
<tr>
<td><strong>Return Timing</strong></td>
<td><strong>Start</strong></td>
</tr>
<tr>
<td></td>
<td>Lets you specify the stop angle.</td>
</tr>
</tbody>
</table>
### Chapter 8: Tooling Design

#### Tooling Design

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start</strong></td>
<td>Specify the start angle.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>Lets you specify the stop angle.</td>
</tr>
</tbody>
</table>
| **Move Distance** | Sets the linear move distance.  
This only applies to linear motion. |
| **Rotation Angle** | Sets the rotation angle.  
This only applies to rotary motion. |
| **From File** | Lets you define the motion from an external CSV file.  
Appears when the Motion Curve is set to From File. |
| **Import Curve Data** | Appears when the Motion Curve is set to From File. |
| **Import Curve File** | Lets you import an external curve file to be used for motion. |
| **Name** | Sets the name for the motion you are defining. |
| **User Defined Motions** | Lets you define a new set of motions to be added to the list. |
| **Add New Set** | Sets the name for the motion that you are defining.  
Indicates whether or not the defined slide is active.  
Previews the motion you have defined. |
| **List** | Let you export the motion curve to an external file for later use. |
| **Preview Motion** | Let you export the motion curve to an external file for later use. |
| **Export Motion Curve** | Set the parameters for the motion. |
| **Settings** | Specify the parameters for the motion. |
| Use Control Data | Uses the kinematic control data for the user defined motion. |
Define Cam

Use the Define Cam command to create, edit, or delete the following types of cams:

- Linear
- Rotary
- Rocker
- Cushion

To define the cam, you can select solid bodies or sheet bodies. You can also select faceted bodies that have solid or sheet bodies associated with them.

A predefined kinematic model contains kinematic data about basic cam actions. You can use this command to define the kinematic data for various types of cams. NX automatically calculates and stores the cam data in the kinematic model.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td>Define Cam</td>
</tr>
</tbody>
</table>
Define Cam dialog box

<table>
<thead>
<tr>
<th>Type</th>
<th>Specifies the type of cam that you want to define.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type list</td>
<td><img src="image1.png" alt="Linear Cam" /> <img src="image2.png" alt="Rotary Cam" /> <img src="image3.png" alt="Rocker Cam" /> <img src="image4.png" alt="Cushion Programming" /></td>
</tr>
<tr>
<td>Cam</td>
<td>The following options appear based on the type of cam you select.</td>
</tr>
<tr>
<td>Select Body</td>
<td>Lets you select the body for the cam you are defining.</td>
</tr>
<tr>
<td>Select Rocker Body</td>
<td>Appears when <strong>Type</strong> is set to <strong>Rocker Cam</strong>. Lets you select the <strong>Rocker Body</strong> for the cam.</td>
</tr>
<tr>
<td>Cam Drive</td>
<td>Lets you select the cam drive body.</td>
</tr>
<tr>
<td>Cam Direction</td>
<td>Lets you specify the movement direction of the cam.</td>
</tr>
<tr>
<td>Specify Vector</td>
<td>Lets you specify an offset value for the cam backstop.</td>
</tr>
<tr>
<td>Backstop Offset</td>
<td>Lets you specify the axis around which the cam rotates.</td>
</tr>
<tr>
<td>Specify Vector</td>
<td>Lets you specify the point of rotation for the <strong>Cam Axis</strong>.</td>
</tr>
<tr>
<td>Specify Point</td>
<td></td>
</tr>
</tbody>
</table>

NX 10.0 Release Notes 8-21
### Rotation Angle
Appears when **Type** is set to **Rotary Cam** or **Rocker Cam**.

Lets you specify the range of rotation from the original position of the cam.

<table>
<thead>
<tr>
<th>Cam List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cam Name</strong></td>
</tr>
<tr>
<td>Sets the name that will appear in the <strong>Cam List</strong> for the cam that you are defining.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Active</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cushion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Body</strong></td>
</tr>
<tr>
<td>Lets you select the body for the cushion you are defining.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cushion Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lets you specify the movement direction of the cushion.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specify Vector Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appears when the <strong>Type</strong> is set to <strong>Cushion Programming</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Motion Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lets you set the total distance of the cushion.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Forward</th>
<th>Start</th>
<th>Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sets the start location of the cushion before it moves forward.</td>
<td></td>
<td>Sets the stop location of the cushion.</td>
</tr>
<tr>
<td>Backward</td>
<td>Start</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sets the start location of the cushion before it moves backward.</td>
</tr>
</tbody>
</table>

| Stop     |       | Sets the stop location of the cushion. |

<table>
<thead>
<tr>
<th>Defined Cushion</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cushion Name</strong></td>
<td>Sets the name that will appear in the Defined Cushion list for the cushion that you are defining.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The name given to the defined cushion.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Indicates whether or not the defined cushion is active.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preview</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark]</td>
<td>Previews the cam or cushion that is selected in the list.</td>
</tr>
</tbody>
</table>
**Define Slide**

Use the **Define Slide** command to define the kinematic data for various types of slide actions. NX automatically calculates and stores the slide data in the kinematic model.

---

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Mold Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>Define Slide</strong></td>
</tr>
</tbody>
</table>

---
### Define Slide dialog box

<table>
<thead>
<tr>
<th>Type</th>
<th>Specifies the type of slide that you want to define.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type list</td>
<td></td>
</tr>
<tr>
<td>Slide</td>
<td>Lets you select the body for the slide you are defining.</td>
</tr>
<tr>
<td>Rotary Cam</td>
<td></td>
</tr>
<tr>
<td>Rocker Cam</td>
<td></td>
</tr>
<tr>
<td>Cushion Programming</td>
<td>The following options appear based on the type of slide you select.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Slide</th>
<th>Lets you select the body for the slide you are defining.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Body</td>
<td>Slide Drive</td>
</tr>
<tr>
<td>Select Body</td>
<td>Slide Direction</td>
</tr>
<tr>
<td>Specify Vector</td>
<td>Slide List</td>
</tr>
<tr>
<td>Slide Name</td>
<td>Name</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates whether or not the defined slide is active.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cam</th>
<th>Lets you select the body for the cam you are defining.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Body</td>
<td>Appears when Type is set to Rocker Cam.</td>
</tr>
<tr>
<td>Select Rocker Body</td>
<td>Lets you select the Rocker Body for the cam.</td>
</tr>
</tbody>
</table>
## Cam Drive

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select Body" /></td>
<td>Lets you select the cam drive body.</td>
</tr>
</tbody>
</table>

### Select Body

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cam Direction" /></td>
<td>Lets you specify the movement direction of the cam.</td>
</tr>
</tbody>
</table>

### Specifying Vector

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cam Axis" /></td>
<td>Lets you specify the axis around which the cam rotates.</td>
</tr>
</tbody>
</table>

### Specifying Point

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Specify Vector" /></td>
<td>Lets you specify the point of rotation for the cam axis.</td>
</tr>
</tbody>
</table>

### Rotation Angle

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Specify Point" /></td>
<td>Appears when Type is set to Rotary Cam or Rocker Cam. Lets you specify the range of rotation from the original position of the cam.</td>
</tr>
</tbody>
</table>

### Cam List

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Cam Name](image) | Name
Sets the name for the cam that you are defining.
This name appears in the Cam List.
Active
Indicates whether or not the defined cam is active. |

### Cushion

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cushion" /></td>
<td>Lets you select the body for the cushion you are defining.</td>
</tr>
</tbody>
</table>

### Select Body

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cushion Direction" /></td>
<td>Lets you specify the movement direction of the cushion.</td>
</tr>
</tbody>
</table>

### Specify Vector

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Specifying Parameters" /></td>
<td>Appears when the Type is set to Cushion Programming.</td>
</tr>
<tr>
<td>Motion Distance</td>
<td>Sets you set the distance that the cushion moves.</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>Forward</strong></td>
<td><strong>Start</strong></td>
</tr>
<tr>
<td></td>
<td>Sets the start location (start angle) of the cushion before it moves forward.</td>
</tr>
<tr>
<td></td>
<td><strong>Stop</strong></td>
</tr>
<tr>
<td></td>
<td>Sets the location where the forward motion of the cushion stops (stop angle).</td>
</tr>
<tr>
<td><strong>Backward</strong></td>
<td><strong>Start</strong></td>
</tr>
<tr>
<td></td>
<td>Sets the start location (start angle) of the cushion before it moves backward.</td>
</tr>
<tr>
<td></td>
<td><strong>Stop</strong></td>
</tr>
<tr>
<td></td>
<td>Sets the location where the backward motion of the cushion stops (stop angle).</td>
</tr>
</tbody>
</table>
### Defined Cushion

<table>
<thead>
<tr>
<th>Cushion Name</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Name</td>
<td>Sets the name for the cushion that you are defining. This name appears in the Defined Cushion list.</td>
</tr>
</tbody>
</table>

| Active | Indicates whether or not the defined cushion is active. |

### Preview

- **Preview**
  - Previews the slide or cushion that is selected in the list.
Define Lifter

Use the **Define Lifter** command to define the kinematic data for various types of lifter actions. NX automatically calculates and stores the lifter data in the kinematic model.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Mold Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>Define Lifter</strong></td>
</tr>
</tbody>
</table>
## Define Lifter dialog box

<table>
<thead>
<tr>
<th>Type</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type list</td>
<td>Specifies the type of lifter you want to define.</td>
</tr>
<tr>
<td>Lifter</td>
<td>The following options appear based on the type of lifter you select.</td>
</tr>
</tbody>
</table>

### Lifter

- **Select Body**
  - Lets you select the body for the lifter you are defining.

- **Specify Vector**
  - Lets you specify the movement direction of the lifter.

### Lifter Drive

- **Select Body**
  - Lets you select the lifter drive body.

- **Specify Vector**
  - Lets you specify the drive direction of the lifter.

### Main Lifter

Appears when the **Type** is set to **Lifter on Lifter**.

- **Lifter**
  - **Select Body**
    - Lets you select the main body for the lifter you are defining.
  - **Specify Vector**
    - Lets you specify the movement direction of the main lifter.

- **Lifter Drive**
  - **Select Body**
    - Lets you select the drive body for the lifter you are defining.
  - **Specify Vector**
    - Lets you specify the movement direction of the drive body of the main lifter.
**Progressive Die Support documentation corrections and additions**

**Unfolding Simulation**

Use this command to simulate the unfolding of a straight break bend.
Part features before the simulation

Part features after the simulation

You can check the self-interference or interference of bends between the other bodies during the unfolding process.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>Unfolding Simulation</strong></td>
</tr>
</tbody>
</table>
**Unfolding Simulation dialog box**

**Stationary Face or Edge**

Let's you select the face or edge that will remain stationary during the simulation.

**Select Face or Edge**

![Diagram of a 3D model with selected face and edge highlighted in pink and blue.]

**Bend**
**Chapter 8: Tooling Design**

**Select Bend**

Lets you select the bend that will be straightened.

**Static Interference Check**

Lets you select a solid or sheet body that NX will use to check against for interference.

**Select Body**

**Animation**

Let you control the simulation.

Control buttons

When you click **Play**, NX runs the simulation from the formed angle of the bend until it is unformed and repeats this until you click **Stop**.
State slider

Lets you manually animate the simulation.

Beginning of simulation at —90 degrees

End of simulation at 0 degrees
**Speed slider**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lets you control the speed of the simulation.</td>
</tr>
<tr>
<td>Drag the slider between 0-10 degrees to set the refresh rate. This controls the speed of the simulation.</td>
</tr>
<tr>
<td>The refresh rate is the number of degrees between each step of the animation.</td>
</tr>
</tbody>
</table>
**General Insert**

Use the **General Insert** command to create outside-insert for punch or die inserts.

You can create an insert by using the **Bounding Box** option that does not require you to create a sketch. For more detailed inserts, you can use the **User Defined** option where you can select curves, or you can use the **Sketch Section** option to open the **Create Sketch** dialog box and specify more complex curves and shapes. You can assign attributes for the inserts from a pre-defined spreadsheet, or you can assign them in real-time.

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>General Insert</strong></td>
</tr>
</tbody>
</table>
### General Insert dialog box

<table>
<thead>
<tr>
<th>Type</th>
<th>Lets you design a new general insert.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Insert</td>
<td>Lets you edit a general insert that has already been defined.</td>
</tr>
<tr>
<td>Edit Insert</td>
<td>Lets you delete general inserts that have already been defined.</td>
</tr>
<tr>
<td>Delete Insert</td>
<td>Lets you select the faces from which the base for the general insert is built.</td>
</tr>
<tr>
<td>Face</td>
<td>Displays a list of available parent components. You will choose one that will be associated with the general insert.</td>
</tr>
<tr>
<td>Parent</td>
<td>Creates a containing box that encompasses the selected faces. Reverses the direction of the generated insert.</td>
</tr>
<tr>
<td>General Insert</td>
<td>Sets a constant offset value for the sides of the insert.</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td>Sets the size of the radius at the four corners of the insert.</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>User Defined</strong></td>
<td>Appears when <strong>User Defined</strong> is selected. Lets you create a new component with a datum plane from which the base for the general insert is built.</td>
</tr>
<tr>
<td><strong>Create Datum</strong></td>
<td>Opens the <strong>Create Sketch</strong> dialog box. Lets you draw a sketch for creating the general insert.</td>
</tr>
<tr>
<td><strong>Select Curve</strong></td>
<td>Lets you select a curve that is used to create the insert.</td>
</tr>
<tr>
<td><strong>Sketch Section</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Curve</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>Sets the start value of the selected curve used to create the insert.</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Sets the stop value of the selected curve used to create the insert.</td>
</tr>
<tr>
<td><strong>Part Attribute</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Attribute of Object list</strong></td>
<td>Displays the current list of attributes associated with the current insert.</td>
</tr>
<tr>
<td>Add Attribute from List Below</td>
<td>Lets you set an attribute for the insert from the Attribute from Spreadsheet list.</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>An attribute must be selected from this list in order to be added.</td>
</tr>
<tr>
<td>New Attribute</td>
<td>Lets you specify a new attribute that you can define in the Attribute of Object list.</td>
</tr>
<tr>
<td>Delete Attribute</td>
<td>Deletes the selected attribute from the Attribute of Object list.</td>
</tr>
<tr>
<td>Attribute from Spreadsheet list</td>
<td>Displays a predefined set of attributes that can be added to the Attribute of Object list.</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>Without False Body</td>
<td>Creates the insert without the false body.</td>
</tr>
<tr>
<td>Rename Component</td>
<td>Lets you rename the component by opening the Part Name Management dialog box when Create Datum is selected under the User Defined type.</td>
</tr>
</tbody>
</table>
**Backing Pad**

Use this command to design backing pads for punch and die inserts in casting dies.

You need to select the target component and the face from which to create the base of the backing pad. Then you need to set the offset value for the sides of the backing pad and specify the height of the pad. No sketching is necessary. The illustration shows a simple punch component and a generated backing pad.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Target component</td>
</tr>
<tr>
<td>2</td>
<td>Selected face</td>
</tr>
<tr>
<td>3</td>
<td>Offset value</td>
</tr>
<tr>
<td>4</td>
<td>Pad height</td>
</tr>
<tr>
<td>5</td>
<td>Backing pad</td>
</tr>
</tbody>
</table>

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>Backing Pad</strong></td>
</tr>
</tbody>
</table>
# Backing Pad dialog box

## Type

**Simple punch or die component**

Creates a basic box based on the selected face.

**Backing pad**

## Bounding Box

1. **Simple punch or die component**
2. **Backing pad**

## User Defined

Let's you select sketch or curve edges to create a custom backing pad.

For example, you could define a sketched profile and create a backing pad that will have the same shape.

## Delete Pad

Let's you delete backing pads that have already been defined.

## Target Component

Let's you select the component for the backing pad.

## Select Target Component

## Face

Let's you select the face from which the backing pad is built.

## Select Face Parameters
<table>
<thead>
<tr>
<th><strong>Offset Value</strong></th>
<th>Sets a constant offset value for the sides of the backing pad.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td><strong>Offset Value</strong> is not available when <strong>Type</strong> is set for <strong>User Defined</strong>.</td>
</tr>
<tr>
<td><strong>Pad Height</strong></td>
<td>Sets the height of the backing pad.</td>
</tr>
<tr>
<td><strong>Boolean</strong></td>
<td>Specifies the Boolean operation between the backing pad and the target body.</td>
</tr>
<tr>
<td><strong>List</strong></td>
<td>Lets you select the target of the <strong>Boolean</strong> operation.</td>
</tr>
<tr>
<td><strong>Select Body</strong></td>
<td></td>
</tr>
</tbody>
</table>
**Slug Retention**

Use the **Slug Retention** command to design a slug retention hole in die openings.

Slugs that become dislocated in stamping operations can damage either the stamped part or the die. The slug retention hole helps to keep the slugs from coming out of the die openings.

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Progressive Die Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Finder</td>
<td><strong>Slug Retention</strong></td>
</tr>
</tbody>
</table>


## Slug Retention dialog box

<table>
<thead>
<tr>
<th>Target Component</th>
<th>Lets you select the component from which the slug retention hole will be created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Target Component Position</td>
<td>Lets you specify the initial location for the slug retention hole.</td>
</tr>
<tr>
<td>Specify Point Dimensions</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>Sets the radius of the slug retention hole.</td>
</tr>
<tr>
<td>A</td>
<td>Sets the rotation angle of the slug retention hole.</td>
</tr>
<tr>
<td>D</td>
<td>Sets the offset distance between the center of the hole and the initial selected location.</td>
</tr>
<tr>
<td>Legend</td>
<td></td>
</tr>
<tr>
<td>1. Hole Radius</td>
<td></td>
</tr>
<tr>
<td>2. Rotation angle</td>
<td></td>
</tr>
<tr>
<td>3. Offset distance</td>
<td></td>
</tr>
<tr>
<td>4. Rotate direction</td>
<td></td>
</tr>
<tr>
<td>5. Offset vector</td>
<td></td>
</tr>
</tbody>
</table>

### Rotate Direction

| Rotate Direction | Lets you specify the Rotate Direction vector of the slug retention hole. |

### Specify Vector Offset Direction

| Specify Vector Offset Direction | Lets you specify the Offset Direction vector of the slug retention hole. |

### Specify Vector
| **Boolean** | Removes the volume of the slug retention hole from the target body. |
| **Subtract** | Lets you select the target body for the **Boolean** operation. |
| **Select Body** |  |
| **Preview** | Displays a preview. |
| **Show Result** | Appears after **Preview** is selected. |
| **Undo Result** | Returns the target body to its previous state. |
Initialize Project dialog box corrections

*Tooling Design → Progressive Die Design → Project Initialization → Initialize Project dialog box*

The existing Initialize Project dialog box documentation does not describe the following option.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Strip</td>
<td>Keeps the design association related to the inserted strip by directly adding it to the project. The strip part may be a subassembly.</td>
</tr>
</tbody>
</table>
Manage Die Base dialog box corrections

Tooling Design→Progressive Die Design→Die Base→Manage Die Base dialog box

The existing Manage Die Base dialog box documentation does not describe the following option.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename Components</td>
<td>Opens the Part Name Management dialog box where you can rename components before you complete a Split Die Plates operation.</td>
</tr>
</tbody>
</table>
Force Calculation dialog box corrections

Tooling Design→Progressive Die Design→Force Calculation→Force Calculation dialog box

<table>
<thead>
<tr>
<th>Define New Process</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Type list</td>
<td>Lists the available Force Calculation process types.</td>
</tr>
<tr>
<td></td>
<td>NX displays a graphical representation labeled with the listed values for the selected process.</td>
</tr>
</tbody>
</table>
Piercing Insert Design dialog box corrections

**Tooling Design** → **Progressive Die Design** → **Piercing Insert Design** → **Piercing Insert Design dialog box**

The existing Manage Die Base dialog box documentation does not describe the following option.

### Cavity and Slug Hole

Appears when you are adding a cavity and slug hole to a casting die base.

#### Cavity Type

- **Taper**
- **Step**
- **Round**

#### Options

Options depend on the type selected.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Depth of hole</td>
</tr>
<tr>
<td>A</td>
<td>Diameter of the die clearance (Step, Round Step 1) Angle of the die clearance (Taper Angle)</td>
</tr>
<tr>
<td>C</td>
<td>Diameter of the slug hole in the bottom backing plate</td>
</tr>
<tr>
<td>Hl</td>
<td>Thickness of the bottom backing plate</td>
</tr>
</tbody>
</table>
Chapter 9: Data translation
Product Notes

Updates in the default tessUG.config JT configuration file

The value of the `JtFileFormat` option in the default JT configuration file is changed from `JtFileFormat = "9"` to `JtFileFormat = "10"`.

If you use the default JT configuration file, NX to JT translator produces version 10 JT files. To generate version 9.5 JT files from NX10, we recommend you to set the `JtFileFormat` option to "9" in the JT configuration file that you use to produce the JT files.

**Note**

- To view version 10 JT files, you must use Teamcenter Visualization 10.1 or later.
- To import version 10 JT files in NX, you must use NX 9 and later versions. If you use older version of NX, we recommend you to produce version 9.5 JT files.
- To import version 10 JT files in SolidEdge, you must use Solid Edge ST7 or later versions. If you use older version of SolidEdge, we recommend you to produce version 9.5 JT files.
- If you intend to import version 10 JT files to any other CAD software other than NX, Teamcenter Visualization, or SolidEdge, we recommend you to check the respective CAD system end user documentation for its compatibility with the version 10 JT file. If the software does not support version 10 JT files, we recommend you to produce version 9.5 JT files.

**CATIA V5 translator product notes**

You can now:

- Import CATIA V5-6R2014 SP1 files to NX.
- Import mirrored assemblies from Catia V5 to NX.
- Export NX files to CATIA V5 R14 or R19 files.

The Flatten option is removed from the CATIA V5 translator’s default settings file, `catiav5.def`. You can still export an NX assembly to flatten it into a single `CATIA V5.CATPart` file. To do this, in the Export to CATIA V5 Options dialog box, under the Export from group, click the Displayed Part radio button and use the Select Objects option in the Export list.
Caveats

Internationalization

- File import or export by the following translators may not work if you set the NX temporary directory `UGII_TMP_DIR` to a folder containing non-locale characters.
  - DXF/DWG
  - IGES
  - STEP
  - 2D Exchange (export only)
- The IGES and STEP translators does not support the exclamation mark ‘!’ character in the input or output filenames.

DXF/DWG translator caveats

- If you export a locked 2D component, the latest component definition is exported to the DXF/DWG file.
  You can avoid this by creating a new component definition. To do this, right-click the 2D component and choose Make Unique.
- 2D components with color override are exported as per the colors set in the component definition.

DXF/DWG – Dimension export caveats
These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG Export Wizard dialog box.

- Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.
- NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.
- The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.
- Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.
- Perpendicular, Chamfer, and Thickness dimensions are exported as block reference to the DXF/DWG file.
- Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.
- Dimension with fits tolerance having fit tolerance style other than Fit Symbol is exported as block reference in AutoCAD.
- Dimension text location may not match with NX for the dimensions created with oriented text.
DXF/DWG – MText import caveats
You cannot import:
• MText paragraph tabs to NX.
• Euro symbol (created using %%%128 in MText) to NX.

2D Exchange caveats
• Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.

2D Exchange – Dimension export caveats
These caveats are applicable for both, when you export a file using the NX Part file option in the 2D Exchange Options dialog box or when you export a file using the 2D option in the AutoCAD DXF/DWG Export Wizard dialog box.

Following dimensions are exported with the Override Dimension Text:
• Feature Parameter Dimensions
• True Length Dimensions
• Dimensions in scaled view and output set to Modeling (applies only when you export a file using the NX Part file option in the 2D Exchange Options dialog box)
• Dimensions associated to:
  o Drafting Intersection point
  o Offset center point
  o Section line (in scaled view)
• The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.
• Linear and Radial callouts
• Retained dimensions
• Component level dimensions and PMI dimensions
• Inherited ordinate PMI dimensions
• Dual dimension in scaled views and output set to Modeling.
• Dimension with hole and shaft tolerance in scaled views and output set to Modeling.
• Dimensions associated with:
  o Blanked objects
• 3D and Symmetric centerlines
• Faces
• Two object intersection (applies to ordinate dimension only)
• Target Points
  • Dimension created in plane other than view plane.

**CATIA V5 translator caveats**

• You cannot translate the CATIA V5 R7 and earlier version of files.
• You cannot translate standard and user defined attributes.
• You cannot translate NX files to CATIA V5 without saving the changes to the NX file. When you select the **Displayed Part** and ** Entire Part** options and export a modified NX assembly file to CATIA V5, in the displayed message box you can click **Yes** to save the part and translate it or click **No** to cancel the translation.
• When you Import CATIA V5 assemblies (*.catproduct) in NX managed mode, CATIA V5 translator does not generate a hierarchical assembly containing component parts and corresponding geometry.
• When you export an NX part with no BRep on the Windows Operating System, CATIA V5 translator no longer generates an empty CATPart.
• Color is supported on a per face basis.
• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.
Chapter 10: Teamcenter integration
Product Notes

Active Workspace

Teamcenter Integration works with Active Workspace 2.2.

Launching NX from the Active Workspace web client is not supported on the Mac.

Use Item Name instead of Number customer default

The **Use Item Name instead of Number** customer default is removed. To specify the display of the Item name or Item ID for an object in NX, specify the desired property as the displayed property in the Teamcenter BMIDE. NX uses the same setting as Teamcenter. This provides consistency for displayed names when viewing objects in Teamcenter and NX.

Variant configuration

The **Variant Configuration** command is removed. To apply a variant configuration to an assembly, load the assembly using the **Variant Rule** option in the **Assembly Load Options** dialog box.
Caveats

Using Active Workspace embedded in NX

When you run Active Workspace embedded in NX, some minor display issues may occur. These include misalignment of items in lists, cutoff text, and incorrect sizing of elements. In general, these issues do not prevent or severely limit the use of the Active Workspace functionality.

Active Workspace preferences

When Teamcenter installs Active Workspace 2.2, the AWC_NX_OpenSupportedTypes and AWC_NX_AddComponentSupportedTypes preferences are not automatically created. You need to manually create and set these preferences in Teamcenter.

Running refile with escape character

If you set the following Teamcenter preference to # so that # becomes an escape character, refile does not work for a part that contains the # character in its ID.

TC_escape_character

Starting NX in four-tier Teamcenter environment with WebLogic 10 MP2

When you are running Teamcenter in the four-tier environment with WebLogic 10 MP2, NX may not start with no error messages displayed. This could be due to problems with the WebLogic server.

Note

This is applicable only when you are using the WebLogic 10 MP2 Application Server.

Perform the following steps to modify the Weblogic XML file:

1. Stop the WebLogic application and locate the tc.war file in the WebLogic domain (typically in the autodeploy directory).

2. Open the tc.war file using Winzip and extract the weblogic.xml file to a temporary location.

3. Open the weblogic.xml file using an editor (XML or text editor) and add a cookie-http-only XML element with the value of false in the session-descriptor element. For example:

   <session-descriptor>
     ...<cookie-http-only>false</cookie-http-only>
   </session-descriptor>

4. In Winzip, delete the old weblogic.xml file.

5. Add the modified weblogic.xml file in your temporary directory into Winzip. To do this, drag the web-inf folder that contains the weblogic.xml file and drop it into Winzip. Ensure the path of the weblogic.xml file is web-inf.

6. Restart the WebLogic application.
Creating an Alt Rep assembly using File New

You cannot have an assembly that is an alternate representation (Alt Rep) that has children that are not also Alt Reps. The part types of the parts (Alt Rep) must match the part type of the assembly (Alt Rep).

However, when you choose File→New to create a new assembly and use the Blank template, NX lets you create an Alt Rep assembly with children that are not also Alt Reps. This causes problems when you use the assembly in NX.

Translators only supported in Teamcenter two-tier environment

Teamcenter only supports the installation of the following NX translators in a Teamcenter two-tier environment, the Teamcenter four-tier environment is not supported:

- NXClone
- NXRefile (not supported on Linux)
- NXtoPVDirect

Teamcenter localizable properties not supported

In Teamcenter, there is now the capability to have the names and values of properties translated and displayed in multiple languages. You can see this functionality in some areas of NX (not all areas of NX incorporate this functionality), such as the Teamcenter Navigator, Part Family template spreadsheet, and New Item, Save, Save As, Import, and component properties dialog boxes. This is applicable for Teamcenter properties such as: property names, property values, list of values, and BMIDE elements (type names).

When you run NX, the language set by the environment variable UGII_LANG determines the language that is used to display the names and values of TC properties in NX.

If you do not have translated values defined in TC for the properties, or you do not want NX to display the translated values, set the following environment variable:

UGII_NO_TC_LOCALIZATION=1

When this environment variable is set, the property values shown in NX are always the internal value (non-translated) and there is no indication in NX that the value has a translated value defined in Teamcenter. This is the same behavior that NX had prior to NX 10. However, the environment variable does not change the way the property names are displayed. If the property name has a translated value that matches the UGII_LANG setting, the translated (localized) name is still shown in NX.

VLA Attribute Affix options modified

The VLA Attribute Affix customer default (Teamcenter Integration for NX→User Attributes, All tab) is modified. The new options [Numeric] and :Numeric introduced in NX 8 caused problems when there are references to VLA (variable length array) attributes in parts created prior to NX 8. The [Numeric] and :Numeric options are now set to _Numeric when selected. You should use _Numeric if you are setting this option for the first time.
Chapter 11: Mechatronics Concept Designer
Product Notes

PLCopen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCopen XML. To enable import of PLCopen XML into STEP 7 5.5 SP 2, a hotfix has to be applied to STEP 7. You can find information about this hotfix at the following:

German:  http://support.automation.siemens.com/WW/view/de/62861211

The hotfix is also available on the NX Installation DVD.
Chapter 12: Line Designer
Product notes

The Line Designer application is included in the typical NX installation. During a custom installation of NX, the Line Designer option is available in the list of modules.

So that Line Designer can access data stored in Teamcenter, NX must be run in Teamcenter Integration mode.

Teamcenter version

The minimum supported Teamcenter version for Line Designer is Teamcenter 10.1.3.

Template files

The standard part files delivered with Line Designer must be imported (installed) into the Teamcenter database to enable access by the New Item dialog box. If this step is not performed, the New Item dialog box displays only blank templates.

Installing templates in a Teamcenter four-tier environment

We recommend that you install the templates in a Teamcenter two-tier environment. If you are required to install in a four-tier environment, perform the following steps to install the templates.

1. Ensure that the following environment variables are set:

   UGII_UGMGR_COMMUNICATION
   UGII_UGMGR_HTTP_URL
   UGII_BASE_DIR
   UGII_ROOT_DIR

2. Open a Teamcenter command prompt and enter the following:

   "%UGII_ROOT_DIR%\ug_clone.exe" -pim=yes -u=infodba -p=infodba
   -o=import -dir="%UGII_ROOT_DIR%\LINE_DESIGNER\templates" -default_a=overwrite
   -default_n=autotranslate -aut=legacy -default_f=infodba:" Line Designer Templates"
   -s=nxdm_template_import.clone"

For more information about installing File New templates, see Install File New templates in the NX help:

   Home
   Teamcenter Integration for NX
   System Setup/Administration
   Installing/creating/modifying templates
   Install File New templates

Factory resource samples

Installation of the sample factory equipment, conveyors, and robots from the manufacturing resource sample library to Teamcenter is highly recommended.

   Factory Resources
   Factory Conveyors
   Factory Robots
Instructions for installing the samples are located in the following section of the Teamcenter HTML documentation:

Home→
Installing→
Installation on Windows Servers Guide→
Adding features→
Manufacturing→
Installing and configuring the Manufacturing Resource Library

4GD support

Optional use of Line Designer with 4th Generation Design capabilities requires application of the Manufacturing for 4GD package (MFG4G1.0.2 and above) to the Teamcenter installation. You can get the Manufacturing for 4GD package from the Product Updates section of the Siemens PLM Software download server.

Home→
Training & Support→
GTAC→
Siemens PLM Download Server→
Teamcenter→ [select from Product Updates list and click Go]
patch→
general→
integrations_and_solutions→
MFG4G

Instructions for applying the Manufacturing for 4GD package are included in the package zip file and are also available as a separate download from the same location.
Documentation notes

While Line Designer can work with either BVR or 4GD data structures, typically the documentation describes the 4GD procedures.
Caveats

Assembly load options and Line Designer

Components (smart objects) must be fully loaded for complete functionality. If the assembly load options **Use Partial Loading** and **Use Lightweight Representations** are selected when parts are loaded, the following issues occur.

- Running **Resize Connector** will always display the alert **Entered size and default size of connectors are the same.**

- The **Show and Hide** dialog does not show the Line Designer commands **Show / Hide Connector**.

- Drag&Drop from Reuse Library onto connectors does not work reliably.

Plant Navigator

- In the Plant Navigator, if multiple entries are selected, the command right-click→**Hide/Show** does not work.

- In the Plant Navigator, on Production Unit type entries (Plant, Line, Zone, Station), the command right-click→**Delete** will always display the error message **Failed to delete Production Unit**.

Smart components

- In the **Column Grid** dialog box, the **Column Data** tab is not working. Column grids can be created, even though error messages may appear.

- In the **Platform** dialog box, the **Decking Material** list selection does not have a visual impact.

Editing smart component sketches

While editing sketches of smart equipment, the 3D object is visible. The sketch nodes can be dragged to edit values.
About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.